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Symbol Usage NOTE
This guide uses the following symbols. e This guide uses Mac OS X v10.3 screen shots and procedures in
the explanations. The screen shots and procedures may vary
. : . . slightly if you are using another version of the Mac OS.
EXPLANATION Informahon essential to operations, such as explanations of e The displayed screens and procedures may also differ slightly
0 functions or terminology, follows this symbol. from the examples depending upon the camera or printer model

in use.
PROCEDURES  Information about the steps to perform follows this symbol.

HINT Operating tips and convenient ways of using the program
follow this symbol. Read these topics as you see fit.

IMPORTANT

Points that you need to follow to perform the procedures and
other important topics follow this symbol. Always read these
topics.

REFERENCE

Supplementary explanations and procedures follow this symbol.
Read these topics as you see fit.

Back Next
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What Can ImageBrowser Do?
This section provides a brief explanation of the ImageBrowser features. Use the Additional Features

e Print images that have been downloaded to a computer.
What You Can Do with a Camera Connected e Edit images and movies.
e Stitch panoramic images.
Convert RAW images to standard images (only models
supporting RAW images).
Extract stills from movies.
Format images as screensaver and wallpaper files.
Export image shooting information as a text file.

e Download images from the camera to the computer.

e Download sound files that you record using the Sound
Recorder feature (only on products supporting the Sound
Recorder feature).

e Save computer images to the camera.

e Select images directly in the camera or memory card and
print them.

e Operate the camera shutter remotely from the computer REFERENCE
(Only On models SUppOftlng remote ShOOtlng) .................. .. o o . ............ . .......

e Check and modify camera settings. e The Canon CD-RQI\/I supphed.vvlth the camera contains My

e Set the My Camera Settings (start-up image, start-up sound, Camera Settings files. These files are.agtomatlcally copied to
operation sound, self-timer sound and shutter sound). (Only your computer when ImageBrowser is installed.

on models supporting My Camera Settings)

View Images

e Display the downloaded images and their shooting
information.
e Switch between display modes (Preview, List and TimeTunnel)

Organize Images

e Assign a Star Rating or keywords to images.
e Sort images according to their shooting date or Star Rating.
e Perform image searches.

ImageBrowser Software User Guide 5 Back Next




Chapter 1 Chapter 2 Chapter 3 Chapter 4 Chapter 5 Chapter 6
Table of What is Downloading and What You Can Do with Viewing Images Organizing Images Using Supplementary Appendices Index
Contents ImageBrowser? Printing Images a Camera Connected Features
XXX X
Guide to the | B Windows (1/2)
This section briefly introduces the purposes and features of the two EXPLANATION
main windows for operating ImageBrowser. 0 Browser Window
EXPLANATION This window opens when you start ImageBrowser. The Browser
Camera Control Window Window is for displaying and organizing downloaded images.
. . . . 866 Browser Window
The Camera Control Window is the window that automatically Folaer @ i | TimeTunne ) |
opens when you connect a camera to the computer or insert a —.% Z
. - & 1S quired Images File Mame: IMG_0001
memory card into a memory card reader. You can download =g T
. . 3] 2006_09_11 File Size 556 KE
the camera or memory card images in a few easy steps. | Boveosiz s
You can also select and print camera or memory card images =% onii 4
directly and change camera settings from the computer. e
ﬁ 2006_09_07 m
a0 6 Canon XXO0000 EGD 03_08
¥ Comment
[r-Acq'u'iw-l'rnages | Print | Setto Camera Remote shooting | i igg::g:j‘z
Downloads using camera B [F IPhoto Library
Press the camera's button — 4 — a, q|| mEE
) - .:\dd... Remove @ El "9 ("a a S
Downloads using computer Canon Camera Wiew Image SlideShow Internet Print ~  Sendto Trash
é,; Starts to download images
Explorer Panel Browser Area
-.':.iu Lets you select and download images
=T |
( Preferences... :J Quit ]
The displayed window may vary slightly for a wireless
connection.
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Guide to the | B Windows (2/2)
HINT ] A contextual menu is, as its name implies, a menu whose
Using Contextual Menus options vary according to the context. It is a collection of the

When you hold down the [control] key and click the mouse most commonly used buttons and commands that apply o a

butt < displaved. This | textual given situation.

utton, a menuis dispiayed. This 1s a contextual menu. Contextual menus allow you to use ImageBrowser more
In ImageBlrowser, you can access many useful functions through efficiently. When you feel comfortable with ImageBrowser, try
contextual menus. '

. using the contextual menus in different situations.
For example, the following contextual menu appears when you

press and hold the [control] key and click an image in the
Browser Area.

8ees Erausaciiindaw
Folder

——f Favorite | All -

- Last Acquired Images

ImageBrowser Help...

View Actual Image  Basic Information

File Name IMG_0001
< # Shooting Date oy mag e Modified: Sat, Sep 8, 2006
1 2006_09_11 Move INade: File Size: 556 K8
3 2006_09_12 Duplicate :]mageTSEe 1PEGuux 1200
it
Send to Trash Sa g !
ound;
;ﬂ Cant_:n amea Export Images... Lotk =
LL: :!c::nes Organize Image v Star Rating
< [ Pictures

5 Processing RAW Images...
|7F 2006_09_07

[7 2006_09_08 Rotate Image...

¥ 2006_09_09 Keyword

[ 2006_09_10 Change Star Rating
lfi 2006_09_11 PhotoStitch...

(5 2006_09_12 Movie Edit...

Extract frames from a movie...

(¥ IPhoto Librai
* o ry Rotate According to Rotation Information

IBE%  Create Image for Email...

IMG_0RQend RGN G002 RGN G 0002 Bl 0004 RGINE.00F5 . PGIMG_0006.JPGIMG_0007..PG

=) view [F vl [Mm——a & [[ i @@
Favorite ~
: k] E ]
Ko ) = &
Canon Camera Wiew Image SlideShove Internet - Print - Send 4o Trash
MG_DODT.jpg

Ne. of images Selected: 1 / Total: 7 images

Browser Area —— Contextual menu
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Downloading Images to a Computer (1/5)

This chapter explains a sequence of ImageBrowser basic procedures in EXPLANATION ]
order, such as downloading images from the camera and printing Connecting the Camera to Download
downloaded images. This section starts by explaining the procedures for Thi on describ hods for downloading i
downloading images from the camera. is section describes two methods for downloading images
shot with the camera to a computer.
IMPORTANT Downloadlng Images with Camerg Commgnds
......................................... You can use this method to download images with cameras
e This guide assumes that all the relevant software programs that support the direct transfer function.
and drivers have been correctly installed on your computer. If = Downloading Images with Computer Commands

you have not yet installed them, read the guides for the

software supplied with your camera and install them. This method uses commands entered on the computer to

download images from a memory card in a camera or in a
memory card reader. This method can be used regardless of
whether your camera supports the direct transfer function or

not.
These methods are explained starting on the next page.

REFERENCE

e This section uses the “Download All Camera Images Not Yet
Downloaded” method, a simple method, to download images.
Chapter 3 explains in greater detail how to select images for
downloading from a camera or memory card and how to
perform tasks such as changing the file destination.

* You can also download sound files to the computer that were
recorded using the Sound Recorder feature. The downloading
procedures are explained in Chapter 3 "Downloading Sound
Files from the Camera."

8 Back Next
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Downloading Images to a Computer (2/5)

PROCEDURES
Using Camera Commands to Download Images

9. Setthe camera to the playback mode with it
connected to the computer.

Please see your Camera User Guide for information on how to
connect the camera to a computer.

The Camera Control Window will open.

The displayed window may vary slightly for a wireless
connection.

If your camera features a @~ (Print/Share) button, it will light
and a Direct Transfer menu similar to the lower right one will
appear on the camera’s LCD monitor.

o060 Canon X00000000(

[—Acqnire—images—{ Print  Setto Camera = Remote shooting |

Downloads using camera

(OlE 0y
m Press the camera's button

Downloads using computer

Starts to download images

s Lets you select and download images
&=

i

— Camera Control Window
N - T

Preferences... )
REFERENCE

e If the Direct Transfer menu does not appear on the camera's LCD
monitor, you cannot download images using camera procedures.

e The content on the LCD monitor and the method for displaying the
Direct Transfer menu may differ between camera models.

ImageBrowser Software User Guide

Chapter 5
Organizing Images

Chapter 6

Using Supplementary
Features

Appendices Index

REFERENCE

e Click the [CameraWindow] icon in the Dock (bar appearing at
the bottom of the desktop) if the Camera Control Window does
not display.

e |[f you do not wish the Camera Control Window to open
automatically when you start up the camera, click the [File]
menu and clear the check mark from the [Displays this screen
when the camera is connected] option.

E g’ CameraWindow Edit Camera View
"00B Cani  srarts the image download... %D
_ Preferences...
Hﬁqmges | Prinf  pisplay Images 3L
| Downloads using cam gemate sho_oting...
Start ImageBrowser BB
Download Sound.
Print according to DPOF settings 6P

Contact Sheet Print
—————————————  One Photo Per Page Print
Downloads using con  Select an image and print

j v Displays this screen when the camera is connected ]
v AUU U UK

Starts to d

e |f a dialog allowing you to select between a camera or memory
card reader appears, select the desired device and click [OK].

Communication Settings

Please select a camera or a memory card.

XOUOOXKXXKHXKHRK = ]]

e ) oD
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Downloading | toaC ter (3/5)
Use the camera to set the direct transfer settings and Displays newly downloaded images by shooting date
2. . 9 or My Category (only models supporting this feature).
press the &\ (Print/Share) button or the SET button.
rﬁ (SNa) Browser Window
REFERENCE falder | (TPreview | List  TimeTunnel | :
.......................................... ([ Favorite | All | Wil e
. . - Last Acquired Images File Hame W]:
* See the user guides for your camera for explanations of the - %gfggg";:?, e m
settings and commands related to the Direct Transfer menu that 1 2005.09_12 e
appears on the camera’s LCD monitor. e s
* You can change the destination folder for images by clicking T g = e
[Preferences] in the Camera Control Window that appears on gogin- e ™ L
the computer. See “Downloading Images Automatically” in = [ Peures =
. . . . 3 2006_09_07 k
Chapter 3 for instructions on how to change the destination {5 2006_09_05 : :
(4 2006_09_09
f0|der. 0060511 -
* By the default settings, downloaded images are saved to the -~ | . |
[Pictures] folder_ ¥ IMG_0001.JPG IMG_0002.JPG IMG_0003.JPG IMG_0004.JPG IMG_0005.JPG
. . . . = oy | veel® e | A & | e J[@@@
The images will display in the Browser Window when the A =
download is complete. [T e gl =B S e
Folders with newly acquired images Downloaded Images

display the symbol shown.

REFERENCE

* You can hide the download mark by clicking the [View] menu,
selecting the [View Settings] submenu and clearing the check
mark from [Show download folder mark].
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Downloading Images to a Computer (4/5)

PROCEDURES
Using Computer Commands to Download Images

9. Setthe camera to the playback mode with it
connected to the computer.
Please see your Camera User Guide for information on how to
connect the camera to a computer.
The Camera Control Window will open.
The displayed window may vary slightly for a wireless
connection.

aMaNal Canon JOUOCKXX

[ Acquire Images | Print  Setto Camera = Remote shooting )

Downloads using camera

Press the camera's button

Downloads using computer

@ Starts to download images

é’@ Lets you select and download images
=

Camera Control
Window with a
Camera Connected

REFERENCE

oooooooooooooooooooooooooooooooooooooooooo

e Click the [CameraWindow] icon in the Dock (bar appearing at
the bottom of the desktop) if the Camera Control Window does
not display.

e |f you do not wish the Camera Control Window to open
automatically when you start up the camera, click the [File]
menu and clear the check mark from the [Displays this screen
when the camera is connected] option.

ImageBrowser Software User Guide

Viewing Images

Chapter 5 Chapter 6

Organizing Images Using Supplementary ~ Appendices Index
Features

REFERENCE

e |f you are using a memory card reader, you can set it using the
same procedures as with the camera to have the Camera
Control Window open automatically. After you set the settings,
the Camera Control Window will open automatically when you
insert a memory card into the reader. As shown, the Camera
Control window appears slightly different from the camera
version, but functions similarly.

0 A6 CANON_DC

—_— F-*cquire Images | Print )

Starts to download images

Camera Control
Window with a
Lets you select and download images Memory Card
Reader Connected

[
—

L0
it

{ Preferences... { Exit d

e Different windows from those shown here may appear for some
camera models. In that case, please read the user guides
provided with the software bundled with the camera.
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Downloading Images to a Computer (5/5)

REFERENCE

oooooooooooooooooooooooooooooooooooooooooo

Communication Settings

e |f a dialog allowing you to
select between a camera or
memory card reader appears,
select the desired device and
click [OK].

Please select a camera or a memory card.
' [ X000OKXOKKKXXHXK ) '

Gt ) G0

2. Click [Starts to download images].

O.606 Canon XXXCOOOXXX

Heqnirt-hnngeﬂ Print =~ Set to Camera  Remote shooting )

Downloads using camera

Press the camera's button

Downloads using computer

() |
Starts to download images

i
=

Lets you select and download images ‘

C Preferences... )

The images will display in the Browser Window when the
download is complete.

ImageBrowser Software User Guide

Displays newly downloaded images by shooting date
or My Category (only models supporting this feature).

:Xa)s)

Browser Window

Folder

L Favorite | All |

- Last Acguired Images
< Z Shooting Date

3 2006_09_11

5] 2006_09_12
= [ My Category

Ty People

s Scenery

&2 Events

44 Canon Camera

[ Movies

= [# Pictures
|7 2006_09_07
[ 2006_09_08
2006_09_03

s

Folders with newly acquired images

{Preview—| List  TimeTunnel !

 Basic Information
File Mame. IMG_0001 |
Modified: Mon, Sep 11,

File Size 592 KE
Image Size 2160 x 1440
Data Type! IPG

Sound o)

Lock: M

o Star Rating / My Category

N

-

IMG_0001.0PG

IMG_0002.JPG IMG_0003.JPG

IMG_0004.JPG

IMG_0005.JPG

N e —

[ ——————
Q @ | Sulecting mager | =

ri
Dddm Remove p

display the symbol shown.

.
| @
Wiew Image SlideShaw Internet

12

= ]

Print -  Sendto Trach

No. of Images Selectad: 1 / Total: 5 images

Downloaded Images
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This section explains how to print images dovx_/nloaded to a computer. It 3 Set the settings in the desired categories.
describes the procedures for printing a single image on a single page. It -
is easy to print photo-quality prints. Selects a printer. Selects the paper size and orientation.
REFERENCE ene One Photo per page Print
.......................................... Printer Preview
e The procedural explanation for printing indexes and the layout f“l”;ixx -
and print function are explained in the Chapter 6 topics, 9
7 H : 172 7 H 17 ( Page Setup... ]
Printing Indexes” and “Layout and Print. ,
Paper size : A4
9. Cdlick animage in the Browser Window to print. OrientaioRN Portri
A blue frame appears around the image. b B o e
bﬁ}.rderless printing on supported
REFERENCE printers.
* You can select multiple images by pressing and holding the
[shift] key or [§8] (command) key while clicking on images. If Page Layout SECRIEE — -
you hold down the [option] and [shift] keys together and click Ve
on two images, you can select all the images between them. -
Select additional information to Copies: L \;
2_ Click [Print] and select [One Photo per page Print] print with VoLggggges: inagedt]d S
from the displayed menu. O g™ o=
[T} Shooting Time & g &l
)< Tr View‘ ‘\E( B B BN Text color: - Rotate Left Rotate Right Tri:n:age
‘emove &'5'; 'ﬂﬂ % ‘ Q W & Close ) ( Print )
Canon Camera View Image SlideShow Internet R — b P
[ One Photo per page Print... ]
La;m e Sets the auto trim (crops Sets the shooting date/time
image edges accordingtothe  imprint and color settings.
page proportions) settings.
ImageBrowser Software User Guide 13 Back Next
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Printing a Single Image on a Single Page (2/2)

Sets the number of print copies. Cli -
ick [Print].
4.
e0e One Photo per page Print o
Page Layout Settings === }
Printer Preview
Name: ™ Auto Trim
[ XXXXX H . @
Page 5 y Select additional information to Copies: 1 )
( e print with your images: —
< Image:1/3 @

Paper size: A4

| Shooting Date
I Sheoting Time § E EE!

Text color: - Rotate Left Rotate Right Trim Image

Orientation:  Portrait

Click [Page Setup] to enable

borderless printing on supported
printers.

(: Close ( Print )

5_ If the Print dialog appears, click [Print].
Printing will start.

Page Layout Settings —

E Auto Trim

o —— (&
Select additional information to Copies: L | Q

print with your images:

Image:1/3

—— A

v

"1 Shooting Date
0 ing Ti . . ;
_| Shoating Time @ a i'il

Text color: - Rotate Left Ratate Right Trim Image

l—r‘ (S Close ) ( Print ) e

Click this button to switch Rotates Click this to use the

between images if multiple images trimming function

images were selected. (crops a portion of
the image).

Back Next
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Viewing Images

Chapter 6
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Chapter 5
Organizing Images

Camera Control Window (1/2)

This chapter explains the procedures performed with the Camera
Control Window.

Selects a Camera Window
function.

To download using camera operations, press
the camera’s Dua button (direct transfer).

006 Canon XX3000000

[ Acquire Images | Print Set to Camera = Remote shooting !

Downloads using camera

You can download all
images at once using
computer procedures.

Starts to download images

Or you can check the Lets you select and download images

images and then
download them using

computer procedures. (| Preferences... ) ( Quit J

Sets the attributes and The Camera Control
destination for images targeted Window will close.*
for automatic downloading.

* It will gray out if you are connected wirelessly.

ImageBrowser Software User Guide

PROCEDURES _ _
Opening the Camera Control Window

m Auto Start Settings Selected
When you connect the camera to the computer and prepare it
for communication, the Camera Control Window will
automatically open.

m_Auto Start Settings Not Selected

After the camera is connected, click the [CameraWindow] icon
in the Dock (bar appearing at the bottom of the desktop) and
the Camera Control Window will open.

* Depending on the selections you make during installation, the
[CameraWindow] icon may not appear in the Dock. In this case,
open the Camera Control Window by double-clicking the
[Applications] folder, followed by the [Canon Utilities] and
[CameraWindow] folders, and double-click the
[CameraWindow] icon.

15 Back Next
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C Control Window (2/2)
To open the Camera Control Window from ImageBrowser’s PROCEDURES
Browser Window, click [Canon Camera] in the Explorer Panel % Closing the Camera Control Window
section or on the Control Panel. . . .
Click [Quit] to close the Camera Control Window.
8emes Browser Window
fiplce { Preview | List  TimeTunnel | aXaYa) Camon XX000000000
{ Favorite | Al | -  Basic Information
= [ Last Acquired Images File Name IMG_0001 m [—Atqm—lmageﬁ Print =~ Setto Camera  Remote shooting ]
<  #j Shooting Date Modified Sat, Sep 9, 2006
B 2006_09_11 File size: S Downloads using camera
SRS e
(& coron coner | - |
- Pures wlarikai
[# zo06_09_07 ey )
|77 2006_09_08
¥ 2006_09_09 v Comment ’
L; 2006_09_10 S a5
g ;gg::g:j; [RE2 Starts to download images
b [ IPhote Library
T Lets you select and download images
IMG_0001.JPGIMG_0002.JPGIMG_0003.JPGIMG_0004.JPGIMG_0005.JPGIMG_0006.JPGIMG_0007.JPG
(=] R View [F i 7od || ~r—————a, 3} EEE
Faverite - ( Preferences... )
: Remove E@ @ 9\" Q E g : 1
R oot /7o 7 When the camera is connected wirelessly, the Camera Control

Window will close when the connection is closed. See the user
guides for your camera for instructions on closing a wireless
connection.
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Downloading Images Automatically—Camera Operations (1/2)

PROCEDURES _ .
% Starting Auto Downloading
1.

Set the Direct Transfer settings on the camera, and
start the direct transfer.

This will download images automatically to the computer.
REFERENCE

* See the user guides for your camera for explanations of the
settings and commands related to the Direct Transfer menu that
appears on the camera’s LCD monitor.

e Sound files recorded using the Sound Recorder feature cannot
be downloaded using the Direct Transfer feature. The
downloading procedures are explained in "Downloading Sound
Files from the Camera."

PROCEDURES _ : :
Changing the Auto Downloading Settings

Change the destination folder for images downloaded to the
computer.

1_ Click [Preferences].

= Starts to download images

Lets you select and download images

£ Quit 3

( Preferences... 3
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2_ Select [Change direct transfer download destination
folder] and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

@ Change direct transfer download destination folder

(_ Change auto download settings

3_ Select a destination folder for the downloaded
images and set the new folder creation method for
downloads, then click [Next].

Proceed to Step 5 if [Finished] displays.

CameraWindow - Auto Download Settings (1)

Specify the location at which to save the image.

A new folder will be created for each of the images' shooting dates in the following
folder, and the images will be saved there,

1Users 000G Pictures ( E
Create Sub folder
' Shooting YearMonthDate G ]
Bxample: 7 | :UsersX000CPictures
[7 20060912
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Downloading Images Automatically—Camera Operations (2/2)
4_ To connect a camera to a computer over a wireless REFERENCE

e The printer settings for printing via a computer can only be
configured for a wireless connection. They cannot be configured

connection to use [Print via a Computer], click
[Settings] and configure the printer to be used, as

well as other settings such as the paper size. Proceed when the camera is connected via an interface cable.
directly to Step 5 if you are not using the [Print via a * See the user guides for your camera for explanations of the
Computer] function over a wireless connection. settings and commands related to the Direct Transfer menu.

r

CameraWindow - Auto Download Settings (2)

Sets the Direct Transfer printer settings in advance.

(This is only applicable to cameras which display the Print menu)

rd N ™\
| Settings... )

( <Previous | ( Finish ) Cancel )

5_ Click [Finish].
The settings have been configured.
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Downloading Images Automatically—Computer Operations (1/3)
PROCEDURES _ _ PROCEDURES _ _
Starting Auto Downloading % Changing the Auto Download Settings
1. Click [Starts to download images] in the Camera ]Eioi?ggge the type of image to download or the destination

Control Window.

Under the default settings, all images not yet downloaded will 1.
automatically download to the computer.

@ Starts to download images
000 Canon XXX —

[—Acquife-}mages | Print = Setto Camera = Remote shooting ] 5“‘@ Lets you select and download images
= 3

Downloads using camera

Click [Preferences].

g Preferences... 4 Quit b
&N Press the camera's button ( )
Downloads using computer 2_ Select [Change auto download settings] and click

[Next].

= Starts to download images
% CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

,‘-Z_’@l Lets you select and download images
E|5

( Preferences... B { Quit b

( Change direct transfer download destination folder

@ Change auto download settings

REFERENCE

------------------------------------------

e Sound files recorded using the Sound Recorder feature cannot
be downloaded using the Auto Download feature. The
downloading procedures are explained in “Downloading Sound

Files from the Camera." )
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Downloading Images Automatically—Computer Operations (2/3)

3_ Select the type of image to download and click [Next]. K. Setthe process to initiate after the images are

CameraWindow - Auto Downloa! Seftings (1) downloaded and click [Next].
Select the image type to be downloaded. To simply display the images in ImageBrowser's Browser
Window, select [Display the folder at the save destination].
& New images To have a different process initiated, select [Perform selected
O Allimages processes consecutively] and select a process in the
O Images whose print order settings were specified with the camera ImageBrowser Automation wizard window.

(O Images whose transfer settings were specified with the camera " .
CameraWindow - Auto Download Settings (3)

Download Options
Specify process to perform after image is downloaded.

— When the download is complete, the original image is deleted from the

"‘ camera.

Place a check mark here if you wish the original image
in the camera to be deleted after downloading.

() Display the folder at the save destination

@ Perform selected processes consecutively

4_ Select a destination folder for the downloaded ( Select.. )
images and set the new subfolder creation method
for downloads, then click [Next].

CameraWindow - Auto Download Settings (2)

ImageBrowser Automation wizard

Specify the location at which to save the image.
Select the process to be performed after downloading the image.

A new folder will be created for each of the images' shooting dates in the following
folder, and the images will be saved there.

Users 3300 Pictures ,-‘W'.‘ @ Display slide show
—_—p () One Photo per page Print
Create Sub folder

) Index Print

| Shooting YearMonthDate 3
Example: [3 Users: 303K Pictures ' — ( oK )
[ ance )
[7 2006_09_12
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6. Toinitiate the selected auto download process REFERENCE
immediately after the camera and computer are o ImageBrowser rotates images to match the camera display
connected, place a check mark beside [Images are orientation. However, it does not alter the image data itself. If a
automatically downloaded to computer while camera rotated image is opened in a program that does not support
is connected]. rotated display, it will appear in its pre-rotation state. See

" Customizing Preferences” in the Appendices for an explanation
of how to alter the image data with rotation information so it
downloads in the rotated orientation.

A check mark cannot be placed in this option if the camera is
connected wirelessly.

CameraWindow - Auto Download Settings (4)

Enable or disable the image auto-download function.

— Images are automatically downloaded to computer while camera is
— connected

( <Previous ) ( Finish ) ( Cancel )

7_ Click [Finish].
This concludes the settings procedure.
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PROCEDURES . e Select images for downloading in the Camera Browser
Selecting Images and Initiating the Download 2. Window g g

1. Click [Lets you select and download images] in the The background color of the selected image will change to

- blue.

Camera Control Window. You can select multiple images by pressing and holding the
— _ [shift] key or [§8] (command) key while you click on successive
Dl starts to downioad images images. You can also select a series of adjacent images by

pressing and holding the [option] and [shift] keys together
R e T while clicking on the first and last images.
¢ ) — 3. Click [Download Images].

Preferences... )
| - - \ m N

The Camera Browser Window will open and display the images

Contalned n the Camera. . IMG_0004. PG IMC_0Q005, PG IMG_0006. PG
Camera Browser Window

eNne Camera Window - Canon XXXXXXXXXX
1 2 3 | ¥ File Information: -
&
File Name: L 3 !
Modified b I v
File Size: -
_e {; {El > B
I =
- | | Salect Image v| ‘ | \ﬂ@ ,'_'I ‘ ﬂ ‘ (=]
Data Type: i - =
¥ Histogram: ’ '-_!;ﬂ 1 --I";
‘gi -— :
Dovenload Images Frint -  Ftart ImageBrowser
¥ Shooting Information:
Item Mame Walue
IMG_0004.JPC IMG_0005.JPG IMC_000&.JPG I
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Checking Images in the Camera before Downloading (2/2)

Confirm whether changes are required for the file
destination or name.

To make changes, click [Change Settings].

CameraWindow - Download images

settings.

I =
N 2] I| *}: Download images according to the following
e &,

- Specify Folder
Save to (Folder Name)

Users: 30000 Pictures
Create Sub Folder

Shooting YearMonthDate

r Specify File Name:
Do not change

Specify a folder as
the destination for
downloaded images.

Set whether or
not to create a
subfolder and
specify the name.

( Change Settings...

4 Cancel ) { Start Downlogd-"}

K. Click [Start Download].
The image will be saved.

REFERENCE

* You can also download sound files to the computer that were
recorded using the Sound Recorder feature. The downloading
procedures are explained in "Downloading Sound Files from the
Camera.”
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To change the file name,
select the file prefix
format and the
consecutive numbering
system.

Click here to change
the destination folder.

CameraWindow - Change Settings

!{ Specify Folder | |Specify File Name ) fF——
Save to (Folder Name

(Users: 23O Pictures [ Browse... )

A subfolder into which the image will be saved will automatically be
created in this folder.

T @ Create Sub folder

' Shooting YearMonthDate )

MNew Name

IMAGE
Example:
[ UsersOGOCPictures
[ 2006_03_12

CameraWindow - Change Settings

" Specify Foldef | Specify File Name }-|

Specify File Name

' Shooting YearMonthDate + Sequence Number |+]

File Prefix:
MG

Assign Sequence No.

Number of Digits: Ty 21(1-9)
Start: 0oL | (0000-9999)
Example:

20060912_0001.xxx

(xxx: file extension will be the same as the original file name)

€ Cancel ) G—eu—-)
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Deleting Images from the Camera

This section explains how to use the Camera Browser Window to delete
images from the camera.

REFERENCE

* You cannot delete protected images (images bearing the [Exl
symbol).

1_ Click [Lets you select and download images] in the
Camera Control Window.

Canon X300000000

[—Acquife-}mages | Print

Downloads using camera

OO0

Set to Camera | Remote shooting ]

O Ty

B

Downloads using computer

é_;;’gl Starts to download images

Lets you select and download images

Press the camera's button

C Preferences... ) Quit )

Camera Browser Window will open.

ImageBrowser Software User Guide

Select images for deleting in the Camera Browser
Window.

The background color of the selected image will change to
blue.

You can select multiple images by pressing and holding the
[shift] key or [§8] (command) key while you click on successive
images. You can also select a series of adjacent images by
pressing and holding the [option] and [shift] keys together
while clicking on the first and last images.

Click (s (Delete).

'

IMC_0005. JFC IMG_0006.JPC

| .. = J | T 9aqx ‘ & ‘.@

2 = @

Dovenload Images Print -  Start mageBrowser

A confirmation dialog will display.

Click [Delete].
The image will be deleted.
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Downloading Sound Files from the C (173)
This topl|c explains how to download sound files recorded with the 2 Click [Download Sound].
camera's Sound Recorder feature to the computer. -
ene Camera Window - Canon J0O00000X
o~

IMPORTANT

.........................................

e This function may not be available with certain camera
models. Check your Camera User Guide to see if your model

supports it.
e Sound files cannot be deleted using the Camera Browser

Window.

REFERENCE

e Sound files recorded with the camera's Sound Recorder feature
differ from the sounds attached to images. They are
independent sound files (WAV type).

PROCEDURES . _
Initiating Downloading

7. Click [Lets you select and download images] in the
Camera Control Window.

Lets you select and download images

C Preferences... ) ¢ Quit )

The Camera Browser Window will open. If sound files are
contained in the camera or memory card, the [Download

Sound] button will display.
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IMG_0001.JPG IMGC_0002.JPC

IMG_0004.JPG IMC_0005.JPC

| | Select Image v| ‘ ‘I_e 'G% '&k :Ef ‘ &3 ‘ E_‘]

IMG_0006.JPC

FY

Dovenload Images Print -

Camera Browser Window

Start ImageBrowser

25

)

Dovwnload Sound
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Downloading Sound Files from the Camera (2/3)

A list of sound files will display. 3

Camera Window - Canon XX000000((

L

Download sound files created using the Sound Recorder.

Cr & &Pﬂ Select the files to download and click the Download Sound button.
[ -

-

Ma. File Mame Recording Date SizelkR)
1. SOR_0004 naEy O& /04705 14:35:46 3536
2. SOR_0003 naEy O&/04/05 14:35:40 3041

3. SDR_D002 v

4
H

06704705 14:35:36 3538

4. SDR_000L ey

4
H

0&/04/05 14:35:32 3041

Select Files - Download Sound

( Cancel )

This symbol appears if the file is protected.

—— This symbol appears if the file has been
downloaded to the computer previously.
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Select sound file(s) to download.

The selected files display in blue.

You can select multiple files by pressing and holding the [shift]
or [§8] (command) key while you click on successive files. If you
hold down the [option] and [shift] keys together and click on
two files, you can select all the files between them.

REFERENCE

e [t is convenient to use the [Select Files] menu to select all the
files, to deselect files, to select protected files or to select files
that have not yet been downloaded.

Click [Download Sound].

T

Mo, File Mame Recarding Date Size{kE)

2.w

3. SDR_0002 @y & = 06/04,05 14:35:36 3536

06/04,05 14:35:46

06/04,05 14:35:40

4. SDR_0001 sy & = 06/04,05 14:35:32 3041

Select Files - f—m-ﬁvnd—;
( Cancel :l

A window for setting the destination folder and other settings
will open.
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Downloading Sound Files from the Camera (3/3)

K. Confirm whether changes are required for the file

destination or name.
To make changes, click [Change Settings].

CameraWindow - Download Sound Files

m Download sound according to the following
\Q? % settings.

- Specify Folder
Save to (Folder Name)
Users: 3300 Documents: CAMONMN_SNDR

Create Sub Folder

Recording YearMonthDate

r Specify File Name
Do not modify

Specify a folder as
the destination for
downloaded files.

Set whether or
not to create a
subfolder and
specify the name.

Click here to change
the destination folder.

CameraWindow - Change Settings

- !{ Specify Folder | [Specify File Name | -
Save to (Folder Name

(Users 2330 Documents: CANMORN_SHDR f Browse... ]

You can create a subfolder in this folder automatically and save sound
files in it.
@ Create Sub folder

' Recording YearMonthDate |+]

MNew Name

SOUND
Example:
[ Users 000G Documents: CANON_SMNDR
[ 2006_03_12

S

.;’ Change Settings...

€ Cancel ) f Start -Downlna__r)

6'_ Click [Start Download].
The file(s) will download to the computer.
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To change the file name,
set the text characters for
the file prefix and the
consecutive numbering
system.

CameraWindow - Change Settings
————

- - " Specify Foldef | Specify File Name
——'- Specify File Name

' Recording YearMonthDate + Sequence Number |+]

File Prefix:
SOR
Assign Sequence No.

)

Number of Digits: 4 (1-9)

Start: 0001 (0000-9999)
Example:
20060912_0001.xxx

(xxx: file extension will be the same as the original file name)

€ Cancel ) G—eu—-)
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Other Feat fthe C B Wind
This section explains the other features of the Camera Browser REFERENCE
Wlndow ..........................................

* You can also download images displayed in the Camera Browser
Window by dragging and dropping them into ImageBrowser’s
Browser Area or Explorer Panel section.

enNne Camera Window - Canon XXXO0000XX
3 ¥ File Information:
File Hame: IMG_0001 JPG
Muodified: O6/09/09 09:15:..
File Size-: 470 KB — |ma.ge !nforma.tion .
LN © e (This will not display if you are
. P using a memory card reader.)
¥ Histogram:
IMG_0001.JFG IMG_000Z2.JPG
4 5 G — Histogram
¥ Shooting Information:
Item Mame Walue
File Natme MG _ Q00T ...
Camera Madel Na.. | Canon W00
Shooting Date/ T, | 0P 09706,
. . . IMG_0004 JPG IMG_0005.JPG IMG_0006.JPG mEEE::g e e .
Changes the size of the image b T T e TTTST Selects whether the image border and
H H H 1 Ay [Aperture Wal.. | 7.1 H H
thumbnail (tiny version). _ Pt by S image number are shown or hidden.
‘ Cigital Zoorm Mare
- 3 mage Size 1G0T 200
8 N U o | | mage Quality Fitie:
[ Flafsh ot
Selects the image selection I Select Image __ | l -—-@ : Q @ |= ‘ & ‘ whie Bdance .[&ug; .
methOd AF Range hiode hacro
) @ o L% \g Parammeters Contrast ..
; e b sharpness ...
: = S o ..
Dowvvrload lmages Frint -  Start ImageBrowser Dowwriload Sound Color Space SR;UBFatIDn b
‘ Selects image 1 of 7 2
Prints the selected images. Starts ImageBrowser. Selects whether the image information

at the window's right is shown or hidden.
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Printing | inthe C (1/4)
This function allows you to select images directly from the camera or 2 Click on one of the four printing methods.
memory card and print them. "
OO0 Canon XX00000XX
EXPLANA"ON " Acquire Imageg| | Print | |Set to Camera = Remote shooting )

Four Printing Methods

|

=
— lPrim All Images

IPrint Contact Sheet of All Images

o

There are four ways to print images from the camera as listed
below.

|

==

%

m Print All Images
Prints all images from the camera in the format of one image
per page.

m Print Contact Sheet of All Images
Prints all images from the camera in an index format (rows of

JPrint according to DPOF settings

2y

Select image and print

images on one page)' Freferemces... 'iL’

= Print according to DPOF settings A print settings window corresponding to the selected method
Prints according to the DPOF print settings set using the will open. Procedures for the respective print settings windows
camera. are explained from the next page onward.

m Select image and print 3_ Set the print settings and click [Print].
Displays a list of the images from the camera, allowing you to Printing will start.

print them selectively.

PROCEDURES
Printing Procedures

1_ Click the [Print] button in the Camera Control
Window.
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ImageBrowser?
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What is

Chapter 2

Downloading and
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PROCEDURES

Print All Images

Sets the auto trim (crops

image edges according to the

page proportions) settings.
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Chapter 3 Chapter 4
What You Can Do with Viewing Images

a Camera Connected

Printing Images in the Camera (2/4)

Selects a printer.

866

The following print settings window will open if you selected
[Print All Images].

Chapter 5 Chapter 6
Organizing Images Using Supplementary Appendices Index
Features

PROCEDURES
Print According to DPOF Settings—Standard

A print settings window similar to the following will open if you
select [Print According to DPOF Settings] and the standard
option for DPOF print settings has been set using the camera.

Selects the paper size and orientation.

One Photo per page Print

Printer

Name:

| XXXXX

[

( Page Setup...

Paper size: A4

Orientation:  Portrait

Click [Page Setup] to enable
borderless printing on supported
printers.

Page Layout Settings ]

@Auto Trim
Select additional information to
print with your images:

["15hooting Date
1 5hooting Time

Text color: -

Preview

Click this button to switch between

“ors 1 S images if multiple images were selected.
4 Image:1/7 8 . .
Sets the number of print copies.
& = =

Click this to use the trimming function
(crops a portion of the image).

Rotate Left Rotate Right Trirn Image

Sets the shooting date/time imprint

and color settings.

( Close ) K Print )

V]

Rotates images.
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PROCEDURES PROCEDURES . .
Print Contact Sheet of All Images % Print According to DPOF Settings—Index
A print settings window similar to the following will open if you A print settings window similar to the following will open if you
select [Print Contact Sheet of All Images]. select [Print According to DPOF Settings] and the index option
for DPOF print settings has been set using the camera.
Selects a printer. Selects the paper size and orientation.
[CHGNG) Index Print
Printer Preview
MName:
[ XXXXX 9
€ Page setup... )

Paper size : A4

Orientation:  Portrait

On printers that support borderless
printing, this feature is not
recommended.

Click [Page Setup] to change this
setting.

Sets the number of print copies. —————— copies:

1 [ : T
Sets the number of Page Layout Settings R — M
rows and columns. Rows:| 3@
Columns: 2| @

Sets the printing settings for ————————Paae Caption Settings — % I Click this button to switch between
shooting information, comments, ¥ Shaoting Information - Page:1/1 : images if multiple images were selected.
headers, footers and page numbers. (" Settings.. )

5 o

Eiler | Footeg B & = L — The functions in this area are
8 Settings .. i W available while any one of the images
( Cose| ) Pim ) displayed below is selected.
4
Rotates Click this to use the trimming function
images. (crops a portion of the image).
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PROCEDURES ] ] The print settings window will open.
Select image and print See two pages back for printing one photo per page. See the

The Camera Browser Window will open and display the camera previous page for printing an index.

images in a chart if you select [Select image and print].

9. Selectimages for printing from the Camera Browser
Window.

The background color of the selected image will change to
blue.

You can select multiple images by pressing and holding the
[shift] key or [§8] (command) key while clicking on images. If
you hold down the [option] and [shift] keys together and click
on two images, you can select all the images between them.

Click [Print] and select [One Photo Per Page Print] or
[Contact Sheet Print] from the menu.

P

IMG_0004.JPC IMG_0005. PG IMG_D00E&. JPG

| Select Image v| ‘ ‘I—IEQ 6% mf ‘ e} ‘

Dovenload Images FFIRT !
One Photo Per Page Print .
Contact Sheet Print
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. 1] . n
Saving the “My Camera Settings” to the Camera (1/8)
This section explains how to save the “My Camera Settings” on your PROCEDURES ] )
computer to the camera or vice versa. % Displaying the My Camera window
IMPORTANT Display the existing My Camera Settings supplied with
......................................... ImageBrowser.
e This function may not be available with certain camera 1 Click the [Set to Camera] tab in the Camera Control
models. Check your Camera User Guide to see if your model " \Wind
supports it. NG
* To save the My Camera Settings to the camera, ensure that .
the software supplied with the camera is installed on the 2- Click [Set My Cameral.
computer. 009 Canon XXXXXXXXXX

r— .
[ Acquire Images  Print] | Set to Camera | l’.emote shooting |
—

EXPLANATION _
What are the My Camera settings?

5et My Camera

The start-up image for the camera and sounds such as the
start-up sound, the shutter sound, operation sound and the
self-timer sound are collectively referred to as the My Camera
Settings. You can add your favorite images and sounds from
your computer to the My Camera Settings in the camera.

Confirms/changes camera settings

L

ﬁ Uploads images to the camera

Preferences... ( Quit )

The My Camera window displays.

Back Next
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Saving the “My Camera Settings” to the Camera (2/8)
3 Change the [Typel. You can save the files that appear in the Computer list as My
- Camera Settings to your camera.

The My Camera Settings (image and sound files) display in the
Computer list. The current camera settings display in the

Camera list. Only the settings that can be changed display. REFERENCE
Switches between e The theme in the [Type] list box contains a start-up image, start-
settings types. up sound, operation sound, selftimer sound and shutter sound
regrouped as a set. By selecting a theme, you can change the
by Camera start-up image, start-up sound, operation sound, selftimer

Type: [ Theme 3 sound and shutter sound in one easy step.

Computer Gaifars ® You can also add new files as My Camera Settings to the

121 CD - |[p:221 Computer list (the procedure is explained later in this section).

221 3321

321 i _ =

ANIMALO22 ( Play ) [(__Delete... )

ANIMALOZZ

BARZL

BASEBALLZ1 4

CHIMPANZ1 b

;‘\t‘tl ¢ Send to Trash )
{ Play p'

Save ToX000 Userd: XXX X Library:Preferences:imageBrowserUserData:MyCameraFiles:

My Camera Settings that are already My Camera Settings in
on your computer display here. your camera display here.
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Saving the "My Camera Settings” to the Camera (3/8)

PROCEDURES . 2. Inthe [Computer] list, select a setting you would like
% Saving the My Camera Settings to the camera t0 add to the camera.
This topic explains how to save the previously prepared My When you select [Theme]:
Camera Settings files to the camera. When you select a setting, the image will preview in the area to
1. Select a settings type. the right and the start-up sound, the operation sound, the self-

timer sound and the shutter sound will play in order.

My Comena When you select [Start-up Image]:
Type: |V Theme @] When you select a setting, the image will preview in the area to
Start-up Image h . ht
.Comput Start-up Sound Camera the r|g o
| e ] — When you select a sound type:
T I, Shutter Sound | When you select a setting, the sound will play automatically.
b ) ( Play ) ( Delete.. ) -
ANIMALO23 yamera
BARZ1 Type: | Theme )
BASEBALL21 a
CHIMPANZ1 Y _ : El_‘;?“”‘“ a8 ;32'2‘;’3
= = r" - i
f'\c‘tl L Send to Trash ] 221 FU I—‘ 3321

Py ) Canon = — - —

ANIMALOZZ ( Play ) ( Delete.. )
Save To:XXXX:Users:XXXX:Library:Preferences:imageBrowserUserData:MyCameraFiles: B

[BARZ1

Save to Camera ) (iEIOSE) |BASEBALL21
: CHIMPANZ1 1
Add (’ Send to Trash )
€ Play )

Save ToXXXX:Users:XXXX:Library:Preferences:lmageBrowserUserData:MyCameraFiles:
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Saving the “My Camera Settings” to the Camera (4/8)

3_ In the [Camera] list, select a setting that you would
like to change and click [

When you click [OK] in the confirmation dialog, the settings file

in the camera will now be replaced with the one you specified
from the computer.

My Camera
Type: | Theme H
Computer Camera
121 [ - | E221
221 Stk
321 M . — i
AMIMALO22 ( Play ) ( Delete.. )
ANIMALO23
Select the setting you want to replace
and click [ - |.
REFERENCE

* Please note that the original settings file in the camera is
overwritten and permanently erased. To restore the original
settings file, you must add it once more to the camera. Before
you overwrite a settings file in the camera, confirm that it
appears in the Computer list.

e The [Return to factory default —
settings] button displays for some 8
camera models. Camera
1121
!T ~ Delete

l ( Return to factory default settings ) '

ImageBrowser Software User Guide

Repeat steps 1-3 to replace all the settings files with those you
wish to save to the camera.

Up to this stage, only the settings in the Camera list change,
not those in the camera itself.

4. Click the [Save to Camera] button.
The settings files in the Camera list are saved to the camera.

Save To:XXXX:Users:XXXX:Library:Preferences:ImageBrowserlUserData:MyCameraFiles:

(" Save to Camera ) (—Ehse%

5_ Click the [Close] button to close the window.
This concludes the procedure for adding settings to the camera.

See your Camera User Guide for instructions on changing the
start-up image, start-up sound and other settings.

IMPORTANT

-----------------------------------------

® Do not break the connection while the My Camera settings
are being saved to the camera.
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Saving the “My Camera Settings” to the Camera (5/8)
REFERENCE PROCEDURES . )
.......... . o o o .. . . e o o 06 6 o o o .l. e o o 6 o o o ... o o o o .l . o % SaVIng the Settlngs to the cOmputer
e To delete settings files in the Camera list, select the file and click . . .
the [Delete] button. For cameras that can only register one My In this procedure, opposite to the previous one, you save the
Camera setting, you cannot delete the setting file. My Camera Settings to the computer from the camera.
. Eﬁ;y]can check the settings in the camera (sounds) by clicking 1. Select an option from the [Type] list box.
. 2. Select the setting you would like to copy from the
| p:221si01 Camera list.
F:321_5101 H H
] [ fcr'(')cn': ?ESE delete afile When you select [Theme]:
ray_)(C_pekere. D) ' When you select a setting, the image will preview in the area to
Click here to check the the right and the start-up sound, the operation sound, the self-
camera settings {sounds). timer sound and the shutter sound will play in order.

When you select [Start-up Image]:
Displays the:caMera settings When you select a setting, the image will preview in the area to

when an image file is selected. the right.

When you select a sound type:
When you select a setting, the sound will play automatically.

My Camera
Type: | Theme "3']
Computer Camera
'SF025 ST e
SMALLDOG21 5 SYIMPHOMY 21
SPACEZ1 = _ —
SYMPHOMY21 ( Play ) —Belete—)
TEL21
ToY22 W
TROPICALZ1 i
WATER21 M4

Back Next
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Saving the “My Camera Settings” to the Camera (6/8)
Click [ . PROCEDURES .
3. e % Using Other My Camera Settings

You can obtain or make My Camera Settings files other than

4- Assign a name to the settings file and click [OK]. those provided with ImageBrowser by the following method.

The settings file will copy to the computer disk. If there is a

settings file with the same name, it will be overwritten. m Using Other Software to Create Settings Files

Repeat steps 1-4 as required to save the settings files you wish You can add images or sound files recorded with the camera as

to copy to the computer. My Camera Settings files after editing them with image or
sound processing programs. You will have to manually add

_ . these files to the My Camera window. The next topic explains
5, Click [Close] to close the My Camera window. the procedures for adding them and some restrictions for
This completes the copying process. creating them.
IMPORTANT

.........................................

* Do not break the connection while the My Camera settings
are being saved to the camera.
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Saving the “My Camera Settings” to the Camera (7/8)
PROCEDURES m Adding new files to the My Camera Settings

Creating and Adding Files as My Camera Settings
9. Create animage or sound file that will become the

camera start-up image or sound setting and save it to
the computer.

This topic explains the requirements for files created as My
Camera Settings using image editing and sound processing
programs and how to add them to the My Camera window.
2_ Click the [File] menu in the Browser Window of

= File Requirements for My Camera Settings
' qui y g ImageBrowser and select [Canon Camera] followed by

Use the following settings when creating image files as start-up

images using an image editing program. [I:]/Iy Camera]. d "
Compression Method: JPEG (Baseline JPEG) The My Camera window will open.
Data Sampling: 4:2:0 or 4:2:2 3. Open the My Camera window and select the settings
Pixels (w x h): 320 x 240 pixels type in the [Type] list box.
Use the following settings when creating sound files using a —
sound processing program. =
. Type: | | v Theme
Compr955|0n MethOd: WAVE (Monaural) Start-up Image(fer common cameras)
Quantifying Bits: 8 bit Compufe :tart—up Lmagl;{only for some DV cameras)
. Tmae rart=
Sampling Frequency: ~ 11.025 kHz or 8.000 kHz - | i o
. . . ANIMA ! Selftimer Sound
Use the following chart as a guideline for the length of sound el Shutter Sound
files recorded with the camera. PR
BASEEALLZ1
T Duration in Seconds CHIMPANZ 1 s
ype 11.025 kHz 8.000 kHz CILDANCIRL— =
e en o Iras
Start-Up Sound 1.0 sec. or less 1.3 sec. or less - - l\ -
i Play ) Connect to camera Canon
Operating Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
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Saving the "My Camera Settings” to the Camera (8/8)

4. Click [Add].

BARZ21_S101.JPC
BASEBALL21_S101.JPG

CHIMPAMNZ1_SI01. PG a
ETHDAMNCEZL 5101, IPC 1
(Cada. ) sendrotrash )
Play C Connect to camera :l
REFERENCE

e The My Camera Settings file cannot be added when the Type list
box is set to Theme.

5_ Select the file you created in the Open dialog and
click [Open].
The selected file will appear in the Computer list.

My Camera

Type: ' Start-up Image({for com._. l':]

Computer

SERACT T SI01 PG
| MG _000 L JPC

KABUKIYO21_5101.JPC m

EImDi21 ind 1o

The newly added settings will appear here.

ImageBrowser Software User Guide

Connect the camera to the computer with the
interface cable and click [Connect to cameral].

KIKORIZL_SI0L.JPG
MATSURIZL_SI0OL.JPG

MNEWYEARZ1_SI0L.JPG s

OLDHOUSEZ1 SI0L.IPC 1

€ Add... ) € Send to Trash B ]
Plav_ ( Connect to camera :l

Save TorXXXX:Users: XXXX:Library Preferences:imageBrowserUserData:MyCameraFiles:

Save to Camera E

You can save the newly created settings to the camera using
the procedures described in the Saving the My Camera Settings
to the Camera section.

The [Connect to camera] option cannot be selected when a
wireless connection is used. Close the My Camera window, and
and then select it from the Camera Control Window that
appears for a wireless connection.

REFERENCE

* To delete a settings file, select it and click the [Send to Trash]
button beneath the Computer list.
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Checking and Modifying the Camera Settings

You can check and modify the camera settings from the computer.
Click the [Set to Camera] tab in the Camera Control

1.
2.

Type the name of the owner of the camera here.

Camera Settings

Canon XN

WlndOW. Camera Model
Click [Confirms/changes camera settings]. iy ate Nertioh RA.0-0
m— oo X0000000K Owner's Name

[———

" Acquire Images Printll Set to Camera IIRemote shooting )
| S—
(; Apply ) (\’ Cancel ) ( OK- ’
‘ﬁ Set My Camera
After you have checked the camera settings and made
"

necessary changes, click [OK].

;??_

Confirms/changes camera settings

&

Uploads images to the camera

Preferences...

This will open the Camera Settings dialog, which can be used
to change the settings shown on the right.
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Yo%lc_arlhcopy images (JPEG only) from the computer to the memory 4. f awindow similar to the following opens, select an
cardin the camera. option as required and click [Add].
IMPORTANT This will add the image.
""""" e Select this to add images to the camera without making changes.
e |f you are using a memory card reader, you cannot download
images to the memory card. Add.image
Aftér performing set up, add JPEC image.
9. Click the [Set to Camera] 000 Canon 00000000 QL,W BN
tab In the Camera Acquire Images anl‘ F— \'IRem () send after changing the image to VGA size (640X480 dots)

Control Window.

14
s

& & (€

Set My Camera

2. Click [Uploads images to
the camera].

(" Cancel " @ '

Select this to resize the image before uploading it to the camera.

REFERENCE

e [f multiple images have been selected, then the selected resizing
- option will affect all the selected images.

Confirms/changes camera settings

Uploads images to the camera

(
| -

Preferences.. ") —s e You can select the [Add image as is] option only when
- - : - - uploading JPEG images based on the Design rule for Camera File
A dialog will appear, allowing you to select image files. system standard. Select [Send after changing the image to VGA
3, Select files to copy and click [Openl]. size (640X480 dots)] for all other images.

* RAW images and movies cannot be uploaded to the camera.
REFERENCE

* You can also copy more than one image at a time.

ImageBrowser Software User Guide 42 Back Next




Chapter 1 Chapter 2 Chapter 3 Chapter 4 Chapter 5 Chapter 6
Table of What is Downloading and What You Can Do with Viewing Images Organizing Images Using Supplementary Appendices Index
Contents ImageBrowser? Printing Images a Camera Connected Features
(XXX X
This section explains the procedures for remote shooting, the process of PROCEDURES _
operating the camera shutter remotely from a connected computer. % Remote Shooting Procedures
Begin the procedure with the camera connected to the
IMPORTANT ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, computer and placed in the correct mode for connection.
e This function may not be available with certain camera 1 Click the [Remote shooting] tab in the Camera
models. Check your Camera User Guide to see if your model " Control Window
supports it. '
e On camera models with lens covers, open the lens cover 2 Click [Starts Remote Shooting].
before remote shooting. -
e Ensure that you turn off your computer’s sleep feature before 3 In the [Choose a Folder] window, select the
you begin remote shooting. The results cannot be guaranteed “ destination folder and click [Choose].

if the computer goes to sleep while remote shooting.

« Except for the shutter button, the camera’s buttons and A RemoteCapture Task window like the one below will open.

switches, including the zoom, cannot be manually operated 4 Click the [Release] button. ©©©° RemoteCapture Task
. . . Il ¥ Hide ViewFinder @ AL H: Release
while the camera is being remotely controlled. The image will record vhe smootng desls | gy o+
e The time lag between pushing the shutter button and the ' D add comments shown below

release of the shutter is slightly longer for remote shooting
compared with the normal mode of operation.

* Depending upon your camera model, a program different
from the one shown here may start up. Please refer to the
manual for the software supplied with your camera if this
occurs.

The image captured by the
camera displays here.

REFERENCE

..........................................

* See the Help menu (it can be opened from the [Help] menu in
the remote shooting window) for detailed operating procedures
for remote shooting.

Switches between showing or
hiding the image.
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Operating the Camera Shutter from a Computer (2/4)

EXPLANATION
Features of the RemoteCapture Task Window

Selects the image’s recording size and resolution Sets the rotation setting of the image being recorded.
This setting cannot be adjusted if the [Auto Rotate] function of

your camera is set to [On].
een RemoteCapture Task

@E' :‘L |_+i Release
= T

¥ Hide shooting details 'F__j 0
You can add a comment to an image by ——————— ! Add comments shown below @— Releases the camera shutter.

clicking to place a check mark here and 1 (You can also release it by pressing the camera’s shutter button
inputting text in the box below. or the space bar on the keyboard.)

Switches between showing and hiding the
viewfinder and the detailed settings sections.

¥ Hide ViewFinder

Viewfinder

Sets the camera’s zoom.

N
‘ﬁ}—— Turns the viewfinder display on or off.
‘@— Resets the exposure, focus and white balance settings.

| Field anglefflash | Shooting settings '

Focusing Point: Flash:

" Automatic selec... 3] [ Off B e Sets the shooting settings. It is divided into the [Field angle/
Macro: FlashQuality: flash] tab and the [Sh_ooting setting_s] tab.

Coff B ) (The settings categories vary according to your camera model.)
AF-assist light:

"0on Iﬂ

AF operation:

" AF unlock Iﬂ
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HINT ] m Saving and Recalling Shooting Settings
Other Remote Shooting Features You can save the current zoom settings and the settings in the
_ _ “Field angle/flash” and “Shooting settings” tabs by clicking the
m Interval Timer Shooting [File] menu in the RemoteCapture Task window and selecting
Interval timer shooting is the method of capturing images in [Save Shooting Settings].
which a set number of frames is recorded at set intervals of time. Later when you wish to recall those settings, click the [File]
Click the [Edit] menu in the RemoteCapture Task window and menu in the RemoteCapture Task window and select [Batch
select [Interval Timer Shooting]. Click [OK] in the warning Shooting Settings].
inerval Timer Shooting message to open the window shown _ i _ ]
vow e totheleft. Set the values and click ® Displaying the Subject on the Camera’s LCD Monitor
Tota No.of Frames g [Start] to start shooting. (Interval: You can use the camera’s LCD monitor or a television
between 5 seconds and 60 minutes; connected to the camera to view the subject while shooting
e Frames: 2 or more) remotely.
SEMERp <play seting: g Click the [File] menu in the
REFERENCE @ @ @ . A ..\ RIS RemoteCapture Task window
* You may not be able to record at the set interval if it is too short O, and select [Camera Display
for the camera to transfer and save the image data. O Cameras Leo moniar Settings] to open a window like
- Shooti Co D the one shown here.
m : . . .
Ilmer 09 |nlg _ ' \ , Select [Video Out terminal] or [Camera’s LCD monitor] and click
Timer shooting is the method by which a single image is [OK].
recorded after a set number of seconds.
Click the [Edit] menu in the RemoteCapture Task window and REFERENCE
— . TS, P R S

* See your Camera User Guide for information about connecting

window like the one shown here. the camera 10 a TV

Set the number of seconds for the
delay and click [Start]. The timer may
be set to a range from 2 seconds to
30 seconds.

Timer Interval [} seconds
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HINT ] _ m [Release Hotkey] Tab
Remote Shooting Default Settings o
You can display the default settings for remote shooting by {_Fl seting: |SReissssHoskey)
clicking the [RemoteCapture Task] menu and selecting Release Hotkey
[Preferences]. CTTO ! You can release the shutter using the

. . key specified here.
m [File Settings] Tab

Preferences

— [ File Settings | Release Hotkey |

Save Images On

Sets whether images are saved only to

@ Computer only

O TEMMMMEREY. - en|computer the computer, or also to the camera’s
File Prefix (Up to 16 characters) memory Ca rd'
Capture .
p—— — Sets the root file name for saved ( Cansl ) @O
Number of Digits Start Images-
5 1 For example, if you type “Capture,”
s . : .
o ure 00001 f|le names are automatically assigned
in ascending order starting from

.Folderll:n wlTit:.h Images are Downloaded ] Ca pture_00001 J pg n.
(Users 000 Pictures

You can also change the number of
assigned digits and the starting

(Gmel ) €790 umber

Folder to which recorded images are saved
(Folder selected in Step 3 of “Remote Shooting Procedures.”)

REFERENCE

-------------------- @ o o o o o o o o o o 8 o 0o o 0o o o e o

e |f you select [Computer only] in the [Save Images On] category,
you can record images even when the memory card in the
camera is full and will not accept more images or when it is not
present.
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This chapter explains the methods for displaying images in PROCEDURES _

ImageBrowser. % Closing ImageBrowser
PROCEDURES Click the [ImageBrowser] menu and select [Quit ImageBrowser]

Starting ImageBrowser or click the red button in the Browser Window.

ImageBrowser will start and open its Browser Window if you :

click the [ImageBrowser] icon in the Dock (bar appearing at the 8|10.0

bottom of the desktop).

LT EBLOWSET

=)

You can also start ImageBrowser by clicking [Start ImageBrowser]
in the Camera Browser Window.

REFERENCE

* Depending on the selections you make during installation, the
Canon ImageBrowser icon may not appear in the Dock. In this
case, start ImageBrowser by clicking the [Applications] folder,
followed by the [Canon Utilities] and [ImageBrowser] folders,
and double-click the [ImageBrowser] icon.
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Selecting Folders (1/2)
In this section, you will learn how to use the Explorer Panel Section to EXPLANATION ]
choose a folder containing the images that you want to see. [Favorite] and [All]
PROCEDURES Two buttons, titled [Favorite] and [All], display in the upper
How to select a folder portion of the Explorer Panel section.
i - : : 806 006
Clicking a folder in the Explorer Panel section displays the Folder s
images it contains in the Browser Area. To hide or show the | : :
. . I — Favorit:
folder contents, click the = or = button beside the folder v T e I e - @) Last AcqueTTages
. |v Z4 Shooting Date w 2 Shooting Date
Explorer Panel —— Last Acquired Images Browser Area | &) 2006_09_11 ) 2006_09_11
) B 2006_09_12 5 2006_09_12
FaldB () Browser Window : |
S oo [ — | Baslc Ifarmation @4 Canon Camera g4 Canon Camera o
[+ & Last Acquired Images File Name: meooer ||l [E Movies < 2 Macintosh HD
T R s R < [# Pictures Pre-Registered < (& Users
i e 1500 01400 [ 2006_09_07 H Folders - @ XXX
N [* 2006_09_08 ‘ @ Desktop
gg Canon Camera Lock: I‘j [ ] 20‘9 [ [1% Documents
. t: e gty [7 2006_09_10 | : [# Movies
[ 2006_09_07 | AT 2] [§ 2006_09_11 | b [@ Music
‘.’.2332:33:33 I [§ 2006_09_12 - [# Pictures
L«‘ 2006_09_10 | .
g;zg:;g:j; If you select [Favorite], folders If you select [All], all the
e that have been already drives that are connected to
registered as your favorites will your computer will display
IMG_0001.JPGIMG_0002.JPGIMG_0003.JPGIMG_0004.JPGIMG_0005.JPGIMG_0006.JPGIMG_0007.JPG . . . . . .
— . — display. You will find it (along with their folders).
- e [T =T IR @ I S convenient to register a folder
[ A ] Remow &P = o ) & ] that you use regularly as a ¢4 Canon Camera
Canon Camers Wiew Image SlideShaw Internet - Print - Send to Trazh . . - 3 Mal:il"ltosh HD
v - favorite. > @ HD1
L Mark indicating there are v 2 F[_..’imie ies
newly downloaded images 3 Music Fils
in the folder. Connected Drives b [ Photo Files 1
Selected folder (4 Photo Files 2

B [7 Photo Files 3
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PROCEDURES

Registering a Folder as a Favorite Folder

m Favorites Selected

Click [Add] at the bottom of the Explorer Panel section, select a
folder in the window that opens and click [Select].

= |

m All Selected

After you open the folder in the Explorer Panel section that you
wish to register, click [Add to Favorites] at the bottom of the
Explorer Panel section.

| Add to Favorites

REFERENCE

e A star symbol displays on the folder icons that have been
registered as favorites ([&).
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Features

Unregistering a Favorite Folder

Select [Favorite], then the folder you wish to unregister, and
click [Remove] at the bottom of the Explorer Panel section.
[ ] RIS

Favorite

| Add... || Remaove
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Changing the Display Mode (1/2)

You can change the display mode in the Browser Window and Browser
Area for ease of use.

EXPLANATION _
Three Display Modes

The three display modes for the Browser Area are the Preview
mode, List mode and TimeTunnel mode, which can be switched
by clicking the buttons at the top of the Browser Area.

| Browser Window

[ Preview | List = TimeTunnel |

v Basic Infarmation

File Mame: IMG_0001
Modified: Sat, Sep 4,
File Size: 556 KB
Image Size: 100 :x 121
Data Type: PG

e Folders display on the left of the Browser Area. Select either
[Favorite] or [All]. The images in the folder you click will display
in whichever mode you select.
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® Preview Mode

Displays the images as thumbnails (tiny versions) at the bottom
of the Browser Area and the selected thumbnail and the
Information Panel (display image information) in the upper part.

Selected Thumbnail ~ Selected Image Information Panel

806 Browser Window
Folder [Preview | List  TimeTunnel |
— Fral A1)

I

||v Last Acquired Images
< 24 Shooting Date

File Size: 556 KB

Image Size 1600 % 1200

Data Type IPG

1 2006_09_11

 Basic Infarmation -
File Name: IMC_000L |
Modified: Sat, Sep 9, 2006

’ 3] 2006_09_12

Sound; i)
” &4 Canon Camera Lotk =
ﬁ HANES w Har Rating
= [ Pictures i
|7 2006_09_07 A -+
[7 2006_09_08
B 2008 v Comment

[ 2006_09_10

[# 2006_09_11

[§ 2006_09_12 ‘ |
[ |7 iPhoto Library

[T

JPGIMG_0002.JPGIMG_0003.JPGIMG_0004.JPGIMG_0005.JPGIMG_0006.JPGIMG_0007.JPG

on [T A &[] e @@ @

| TR

Favarit \
o e\

_m:- Remove E’@ E '\9)’ a a S

Canon Gamera View Image lideShow Internet Print  w  SendtoTrash

No. of Images Selected: 1 / Total: 7 images

You can change the thumbnail size.
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Changing the Display Mode (2/2)

m List Mode

Uses the entire Browser Area to display image thumbnails (tiny

versions).

8ene Browser Window
Folder

! preview | List | TimeTunnel !

— Favorite | All -

- [E Last Acquired Images

- #5 Shooting Date \ v .r
[Z 2006_09_11 .
] 2006_09_12 #

4l Canon Camera IMG_0001.jpg IMG_000Z.jpg IMG_0004.jpg
[# Movies e |
= [# Pictures
|7 2006_09_07
[7 2006_09_08
¥ 2006_09_09
[[7 2006_09_10
t: 282272371; IMG_0005.jpg IMG_0006.jpg IMG_0007.jpg
3 | ¥ iPhoto Library
(= T View |;X? Filter Toal !ﬂ"‘_e—' Q. ey ‘l Selscting bmages
Favorite - B r
" ol \ -
Add.. Remov e = = ] =
Canan Canera Wiew Image lideShow Internat - Print

No. of Images Selected: 1 / Total: 7 images | 2

You can change the thumbnail size.
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TimeTunnel Mode

Displays image
a concentric gri

866
Folder

(“Favorite | All |
< [E Last Acquired Images
<  # Shooting Date

& 2006_09_11
3] 2006_09_12
g4 Canon Camera
[# Movies
= |# Pictures

1 2006_09_07

1 2006_09_08

9 2006_09_09

[# 2006_09_10

[§ 2006_09_11

[(§ 2006_09_12
[ |4 iPhoto Library

[ o ] Tainr! ‘
Favorite
[ Add. | ‘
REFERENCE

thumbnails (tiny versions) chronological order on
d that looks like a time tunnel.

Browser Window

! Preview | List | TimeTunneI_];

il filgsne @ WWlHH‘

Canen Camera Wiew Image SideShow Internst v Print w  Sendto Trash

No. of Images Selected: 0 / Total: 2 images |2

Use this Control Panel to move the display.

* See the Sorting Images by Date and Time-TimeTunnel in Chapter

6 for instructio
settings.

ns for operating TimeTunnel and adjusting its
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Changing the Browser Window Display (1/3)

This section explains how to switch between showing and
hiding each panel in the Browser Window and how to display
information other than file names by the thumbnails.

PROCEDURES _ .
Switching between Showing/Hiding Panels

You can use the Display Control Panel to switch between
showing and hiding the Control Panel, Explorer Panel section
and Information Panel when the display mode is set to Preview
or List mode.

Information Panel

ann

Browaer Wandow
Faldar

Proview . List  TimaTunesl
- <

[ Favorice At
w & Last Acqured images
= 4 Shooting Date
3 2006_09_11
= 2006_09_12

Switches between
showing/hiding the
oo Explorer Panel section.

14 2008_09_10
8 2006_09_11

L8 2006_09_12 7 : = LT
b L Phocg Lierary _‘?__.- = ._ 1=
e = =TT T
i
= B { = Jesfies
Explorer Panel Section Control Panel

Switches between showing/
hiding the Control Panel.

Switches between showing/hiding
the Information Panel.
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Changing the Browser Window Display (2/3)

PROCEDURES

Filtering the Thumbnails Displayed

You can filter the images displayed in the Browser Window.
Click [Filter Tool] and select a criterion to display only the

images corresponding to that criterion.

8ne8 Browser Window
folcer { Preview | Li TimeTunnel |
‘Favorite | All - = =  Basic Infarmation
- Last Acquired Images File Name IMC_0001 m
- 74 Shooting Date Madified Sat, Sep 9, 2006
3 2006_09_11 File Size 556 KB
@ 2006_09_12 Image Size 1600x 1200
- Data Type: PG
Sound
¥ Canon Camera Lack -
L__Q_ M-{WISS w Har Rating r-'
~ [# Pictures 4
[ 2006_09_07 W (== b

|1 2006_09_08
[ 2006_09_09
[ 2006_09_10
[§ 2006_09_11
[§ 2006_09_12
b [¥ IPhote Library

IMG_0001.JPG IMG_0002.JPG

=

Filter by Star Rating:‘ ™ 28

IMG_0003.JPG

IMG_0005.JPG
Jalr

IMG_0004.JPG

(B s ® vyl

Q| e @@ 3

8 View |0  Filter Tool & | o
e —
Favorite — o
o i
Canen Camera View Image SlideShow
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?

Internet

2

Print

El

w  SendtoTrash

No. of images Selected: 1 / Total: 7 images |
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00000
[[7 2006_09_08
[ 2006_09_09
[ 2006_09_10
[§ 2006_09_11
[§ 2006_09_12
I |7 iPhoto Library
IMG_0001.JPG IMG_0002.JPG
Filter by Star R.aling'.‘ = ﬂi ! TQ?TQ? =] ﬁl{\\fﬁ
p— e —— La‘| Selecting Images =
Favorite
T e & = o k] = 3
E Canon Camera View Image SlideShow Internet Print w  Sendto Trash
No. of Images Selected: 1 / Total: 2/7 images Vi
Select Criteria

To display all images again, click [Filtering] again.

REFERENCE

* See “Setting Star Ratings” in Chapter 5 for instructions on
settings star ratings.
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Changing the B Window Display (3/3)
PROCEDURES . . . . . PROCEDURES . .
Setting the Information Displayed with Thumbnails % Sorting Thumbnails
You can set the image information that displays beneath thumbnails You can select the criteria for the display order when the
when the display mode is set to the Preview or List mode. display mode is set to the Preview or List mode.
Click the [View] menu, select the [View Settings] submenu and Click the [View] menu, select the [Sort] submenu and place a
place a check mark beside a display option. check mark beside a criterion.
z @ ImageBrowser File Edit Internet  Window Help r_@ ImageBrowser File Edit [UETE Internet  Window Help
New Browser Window New Browser Window
View Mode > View Mode »
“' File Name View Settings >
Sort »| File Size :
| : . v File Name
kP)Iaclg a cfclﬁckl markt_ o N | :::g;::g ?m Place a check mark beside — - File Modification Dare
eside a dispiay option. Enlarge #E+ 1 File Modification Date the sorting criterion. Erlliii)rgi ¥+ e Si_Ze i
Reduce - Favorite e = Shooting Date/Time
View Actual Image My Category Type
—— — Comment View Actual Image v Ascending
Show AF Frame | ExplorePanel Show AF Frame Descending
Show Shooting Information I v Control Panel == S = =
Siide Show: - E + Information display panel Show Shooting Information
Slide Show Options... | v Show download folder mark slide Show...
Refresh %R Slide Show Options...

Refresh H#R

Switch between ascending
and descending order.

Example showing the IMG_0001.JPG IMG_0002.JPG IMG_0003.JPG

“File Name”, ——  Thu,Sep 9, 2006  Thu, Sep 9, 2006  Thu, Sep 9, 2006
“Shooting Date” and 9:15:22 AM 9:19:23 AM 10:17:14 AM
“Shooting Time" L - !
selected. View [§F rirton | ‘ —— a @ ‘ [
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Opening Images

This procedure involves opening the Viewer Window from the Browser
Window to open images.

PROCEDURES i
How to open an image

Double-click the image that you want to open in the Browser
Area to open it in the Viewer Window.

ene Browser Window
Folder

- Last Acquired Images

<  #j Shooting Date
3 2006_09_11
3] 2006_09_12

Preview | List | TimeTu

@4 Canon Camera
[# Movies

< [# Pictures .,
E 2006_09_07 Double-click the
| 2006_09_08 W
i 2006_09_09 thumbnail of the
[‘}f 2006_09_10 H
P image that you
[ 2006-03.12 want to see.

B [7 IPhoto Library

IMG_0001.JPG . IMG_0003.JPG v
BHFH L IMG.0002J7C
Viewer Window
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PROCEDURES

Opening several images

You can select multiple images by pressing and holding the
[shift] key or [§8] (command) key while you click on successive
images. You can also select a series of adjacent images by
pressing and holding the [option] and [shift] keys together
while clicking on the first and last images.

Once you have selected multiple images, you can open all of
them at once by clicking [View Image] in the Control Panel.

REFERENCE

e Using the|  swedimaimss=s  _Imenu in the Display Control Panel is
convenient if you wish to select or deselect all the images or
select images that meet certain criteria.

L |
IMG_0002.JPG IMG_0003.JPG

Iter Toal - ‘ﬁﬁ '-.‘1 q
s @

Yiew Image SlideShow Inter e

IMG_0004.JPG IMG_0005.JPG

N Tyl
Selecting Images | E £
Select All
Deselect All
Select By My Category

Mo. of Images Selected: 1 / Totak 7 images &
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00000

Using the Viewer Window (1/5)

This section explains how to use the Viewer Window. PROCEDURES

Using the Full Screen Display
You can display an image at the full screen size by clicking [Full
Screen] in the Viewer Window. To restore the standard display,

PROCEDURES _ _
Opening the Previous or Next Image
click the mouse or press any key on the keyboard.

You can display the image before or after the displayed image

by clicking [Back] or [Next] in the Viewer Window. — —
<« » a =H ® 3 % G \

REFERENCE

e |f you select multiple images and display them in the Viewer
Window, you can click [Back] or [Next] to move the selection

between images.

PROCEDURES _ _ L

% Changing the Display Magnification .
You can change the image display magnification using the w2 )

S - B | 2=l 2zl 29

Humber of
Full Soreen Print Show Information -
36 %

Edit &  Displays w  Synchronize

menu beneath the images.

[' Fit to window =) l Tty };j
@ =T E 2 3 =2 |

Humber of
Synchronize Full Sereen Frint Shaw Informnation

4 »

Back Neset Save Edit  Displays
3%

Display

Display Size: 1600 x 1200
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Using the Vi Window (2/5)
PROCEDURES

Displaying Multiple Images

You can display two to four images at once in the Viewer
Window by using the [Number of Displays] menu. Use it to
compare images with the same subject shot with different
settings or from different angles.

N NSy . 2 ARCaN W eTEn
| Fit to window } ‘.r] Tere |..;.j

: . -~

4 »r i 3 2 &1 =
3 )

Back Mext Save Edit e Dizplavs - Sunchronize Full Screen rint

® Single View Display :
2-Page View (Arrange horizontally)

2

Shaw Information

Display Size: 1600 x 1200

2-Page View (Arrange vertically)
3-Page View
4-Page View

Example of a 4-Image Display

ana 20060909

Currently selected image. —
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When multiple images are displayed in the Viewer Window,
clicking the [Back] and [Next] buttons replaces all the images
with the next set of images before or after the displayed
images.

PROCEDURES . _
Synchronizing Multiple Images

When multiple images are displayed in the Viewer Window,
clicking [Synchronize] sets the display magnification and
position on the image to the same for all images.

2006_09.09

Synchronizes the
display
magnification
and display
position.
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PROCEDURES

Displaying Image Shooting Information

Clicking [Show Information] and selecting [Show Shooting
Information] from the menu displays the shooting information

for the images. Shooting Information

L4IMG_0001JPG

80686

Display Size: 1600 x 1200

REFERENCE

..........................................

e For instructions on how to change the information display
category, see “Customizing Preferences” in the Appendices.
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Features

Converting and Displaying RAW Images

RAW images display in the Viewer Window like standard
images, but not using the full RAW image data. An easily
displayed version is used. Click the [Show Original Image] to
convert the original RAW data and display it in the Viewer
Window.

[57] CRW_0015.CRW

4 Show Original Image 3

[ Fit to window bi-]\’ ety [._,.]‘
« » | B @& H ® = - =

er o
Back Next | Save Edit w  Displays w  Synchronize Full Sereen Print Show Information

* RAW images cannot be edited or saved in the Viewer Window.
See “Converting RAW Images” in Chapter 6 regarding editing
and saving RAW images.
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Using the Viewer Window (4/5)

PROCEDURES _
Playing Movies

Movie control buttons appear at the window’s bottom left
when you display a movie in the Viewer Window. Use these
buttons to start/stop movies.

Chapter 4 Chapter 5 Chapter 6
Viewing Images Organizing Images Using Supplementary ~ Appendices Index
Features
00000
PROCEDURES

Printing Displayed Images

You can print the displayed image by clicking the [Print] button.
See “One Photo Per Page” in Chapter 2 for printing instructions.

8ee6 L.4IMG_0001.JPG
8686 FIMVI_1357.AVI
{Fit to window =) E’ TINr M‘
B s toine r = { Pee E & L N
it to window li’ ﬁfj | ‘ ’ f‘ d Nur%lof L—.ﬁ ;-:1 o Q
= £ - Back MNext ave Edit Displays ~«  Swnehronize Full Screen Print Show Information
‘ ’ [ f iy :]\ Nur%ﬂf ﬁ ! !_‘. Q Display Size: 1600 x 1200 Display : 6% 4
Back Next | safe Edit Displays +  Sywhronize Full Soreen Print Show Information
Mavie Size: 320 x 240 Display 157%
Buttons for Extracts stills
controlling from movies.
movies.
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Using the Viewer Window (5/5)

PROCEDURES _ _
Closing the Viewer Window

Click E to close the Viewer Window, or click the [File] menu
and select [Close].

REFERENCE

e See the Editing Images in Chapter 6 for information on the
Viewer Window’s editing function.
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Selecting Images

This chapter explains the features in ImageBrowser for managing PROCEDURES ]
images. % Selecting All Images

You can select all the images displayed in the Browser Area at
once by clicking the [Select Image] menu in the Control Panel
of the Browser Window and selecting [Select All].

In this section we reintroduce the methods for selecting images in the
Browser Area as one of the basic image management procedures.

PROCEDURES _ _
Selecting a Single Image - | | |
IMG_0001.JPG IMG_0002.JPG IMG_0003.JPG IMG_0004.JPG IMG_0005.JPG
Jal»

;]
wew [ s —||—O——a & ams

’ Select All

— - All
@ "}“l 3 Select By My Category »
Canon Camera Miew Image SlideShow Internet

Click an image to select it. The background color of the \I
selected image(s) will change to blue.

¥ cUUb_UY_uUY .
[ 2006_09_10
[# 2006_09_11

lj 2006_09_12 —
b [ IPhoto Library S No. of Images Selected: 1 / Totak 7 images ¢
IMG_0001.JPGI§G_0002. JPGIMG_0003.JPGIMG_0004. JPGIMG_0005.JPGIMG_0006.JPGIMG_0007.JPG PROCEDURES
] lecting All |
_ Bl S & & e Deselecting All Images
A |

ROCEDIRE Deselect all the images at once by clicking [Selecting Images] in

sSeIecting Multiple Images the Control Panel in the Browser Window and selecting
% [Deselect All].

To select multiple images, press and hold the [shift] key or [3§] I o | | |

(command) key while you click on successive imagesl You can IMG_0001.JPG IMG_0002.JPG IMG_0003.JPG IMG_0004.JPG IMG_DDDS.:PQ
. . . . . = ;) alr
also select a series of adjacent images by pressing and holding | aa (=
. . . . . o i o Filter Tool - ‘—6— S m L&
the [option] and [shift] keys together while clicking on the first ) DR s
i : : | Il
and last images. 3 3 - BT
Canan Carnera Migwe Irnage SlideShonw Internet T PRI S e TrEs

Mo. of Images Selected: 1 / Total: 7 images P
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Setting Star Ratings (1/2)

This section explains the procedures for setting Star Ratings used in
image searches and to display subsets of images.

EXPLANATION _ _
What is a Star Rating?

You can assign one of three ratings [[I0 |, [0 ], [d] to an

image. When a camera image is downloaded to the computer

it is assigned a two-star [ ] rating.

PROCEDURES _
Setting the Star Rating

To set a rating for an image, set the display mode in the

Browser Area to Preview, select the image, and choose a rating

from the [Star Rating] menu in the Information Panel.

Browser Window

E Preview | List | TimeTunnel :'

.1.1_:

l v Basic Infarmation

File Name:
o dified:
File Size: 556 KB

Image Size: 1600 x 1200

[ata Type: JPG
Sound:

Lock: Lol

IMCG_0001

Sat, Sep 9, 2006
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H

IN

I

Chapter 6

Using Supplementary
Features

Chapter 5

Organizing Images Appendices Index

Other Settings Methods for Star Ratings

Menu Method

Select the image in the Browser Area, click the [Edit] menu and
select [Change Star Rating] in the submenu, followed by your
ratings choice.

File Information Dialog Box Method

Set the display mode to [List] or [TimeTunnel].

Select the image in the Browser Area and click the [File] menu
and select [Get Info]. In the File Information dialog box, set the
Star Rating in the list box.

noe File Information
w Star Rating P
(v ™
w Comment
( Hide Detail )
File Hame: IMG_0001! v Reyword
Madified: Tue, Sep 9, 2006 9:52 AM L: View /Modify Keywords... :)
File Size: 580 KB
Image Size: 1600 1200 w Erightness Histogram
Data Type: JPG
Sound:
Lock: ]
I‘
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Setting Star Ratings (2/2)

Viewer Window Method

Display the image in the Viewer Window and set the Star
Rating in the list box.

e L4 IMG_0001.JPG

<« » & = ® 3 2

Back Mheset, Save Edit

<
]
2
W
E
z
b
£
S
'

rint Show Information
Display Size: 1600 x 1200

Disglay - 36%
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Slide Show Method

While a slide show is in play, use the menu at the bottom of the
window to set the Star Rating for the displayed image.
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Using the My Category Function

This section explains the My Category function used to filter or
select images.

IMPORTANT

e This function may not be available with certain camera
models. Check your Camera User Guide to see if your model
supports it.

EXPLANATION _
The My Category Function

Cameras that support the My Category function can classify the
recorded images into categories (People, Scenery, Events, To Do
and custom categories). After images have been downloaded
to a computer, you can classify images using the My Category
function and perform batch operations on images.

PROCEDURES
Displaying the Last Acquired Images by Category

Select the [My Category] folder in the Last Acquired Images

Chapter 4
Viewing Images

section.

ene Browser Window

Folder M\ List TimeTunneIJ
—{ Favorite | All !

 Basic nfarmation -
- Last Acquired Images File Name — !
<  #j Shooting Date Modiie d:
3 2006 09_11 File Size

Image size

Data Type:

Sound

Lack:

M My Category
My People

i Scenery
&9 Events

w HarRating / My Category

W

(@ Movies
= [#@ Pictures =2 LA

7@ ?2nnA Na n7
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PROCEDURES
% Filtering Images with the My Category Function
1_ In the [Filter Tool] menu, select [My Category].
=)=

= ] = ]

SlideShow Internet Print ~  Send to Trash

J ===t Eh o |
% My Category

No. of Images Selected: 1 / Totak 2 images /

2. Selectacategory with the buttons that appear. The images
corresponding to the selected category will display.

[ IPhoto Library

ri\terbyMyCategorv.‘ @ Al Images C-%D Cm C@ (@) G (@) & O & O Q

V‘“WMP_@—J\«LH&H@
o 4 @ & =

Canon Camera Wiew Image SlideShow Internet o Print w  Gendto Trash

(o= —ais

Favorite

No. of Images Selected: 1 / Totak 2 images

PROCEDURES
Selecting the Images from the Specified My Category

Click the| swamsmss _Imenu and select a category
from the [Select By My Category] submenu.

— . — e e
Select All
Favorits mm— —. | Deselect All
oill \ =
Add... Remove ey l People Select By My Category »
Lanon Camera Wiew Image B hn{ Scenery P —

Events | No. of Images Selected: 1 / Total: 2 images I/
Category 1
Category 2
Category 3
To Do
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Assigning Keywords (1/2)

]Ihls sectlﬁn explains the procedures for assigning keywords to images 3. Place a check mark beside appropriate words in each
OF SEArcnes. category, such as People, Places, Events or Others, and
EXPLANATION click [OK].

Keywo rds Keywords Setting
A keyword is information used to perform searches on images. ool Paces Lo Gy
Select a keyword that matches the image content from the S S S
keywords in categories such as People, Places, or Events. For [ Friends C Home O party
example, if you have an image from a family holiday to the
ocean, you might assign keywords such as Family in the People
category, or Beach in the Places category or Holiday in the ‘
Events category. - . ———
ROEDURES ( ' )
Assigning Keywords Toadd MR 1o the sy type the nae in the text field below the desired category,
and press the [+] button.
9. Setthe Browser Area to the Preview mode and select (Cancel ) (__ok_)
an Image. Place a check mark beside To add a new keyword, type it in the box and
2. Click [View/Modify Keywords] in the information SPPlgpriate keywougs: click [+].
display panel.

Browser Window

— {Wew | List | TimeTunnel -

w Comment

< |

View/Modify Keywords ‘l.l

w Eeyord

The View/Modify Keywords window will display.

ImageBrowser Software User Guide 65 Back Next




Chapter 1 Chapter 2 Chapter 3 Chapter 4 Chapter 5 Chapter 6

Table of What is Downloading and What You Can Do with Viewing Images Organizing Images Using Supplementary Appendices Index
Contents ImageBrowser? Printing Images a Camera Connected Features

Assigning Keywords (2/2)

HINT
Other Ways to Assign Keywords 2. Add, delete or restore keywords.

Manage Keywords

Menu Method Feople 2
. . ) ) I Children
Select an image in the Browser Area, click the [Edit] menu and O3 Family
select the [Keyword] submenu, followed by [Settings]. T Friends 0 2id o 1ol Kewand s the syster choone e
field, and press the [+] button. To delete a keyword,
File Information Dialog Box MethOd ;T;tcci'(n'fhe corresponding box and press the Delete
Set the display mode to List or TimeTunnel. Select an image in ( e ——r—
the Browser Area, click the [File] menu and select [Get Info]. In
the File Information dialog box, click [View/Modify Keywords] LESSND <> |
and assign keywords. e
{ Delete
PROCEDURES  cancel ) ( 0K )

% Managing Keywords
» Add Keywords

1- Click the [Edit] menu and select theglRCyWiord] Select a category from the list box, type a new keyword into

submenu, followed by [Manage]. the text box at the bottom of the list and click [+].

The Manage Keywords window will open.
m Delete Keywords

Select a category from the list box, place a check mark beside
the keyword and click [Delete].

Restore Keyword List

This function restores the keyword list based on the keywords
assigned to images. This is convenient if you deleted a keyword
that was used in the past.
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Sorting Images (1/2)

You can sort selected images into folders by the shooting dates or by
Star Ratings.

PR@ES
1.
2.

4,

Selecting a Sorting Method

Select the images to sort in the Browser Area.

Click the [File] menu and select the [Organize Image]
submenu, followed by [Sort Images].

The Sort Images dialog will appear.

Select the shooting date option or Star Rating option
and click [Next].

3.

Sort Images

Select the sort method for the selected image's folder.

® The files will be separated into folders for each shooting date.

() The files will be organized by Star Rating.

{ “€ancel )

ImageBrowser Software User Guide

Chapter 6

Using Supplementary
Features

Chapter 5

Organizing Images Index

Appendices

Set the options and click [OK].
The program will start sorting the images.

The dialog box contents and procedures are explained in the
following pages.
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Sorting Images (2/2)

EXPLANATION
When [The files will be separated into folders

for each shooting date.] is Selected

Organize by Shooting Date

The files will be separated into folders for each shooting date.

Save To:

A new folder will be created in this folder.

Macintosh HD:Users:XXXXX:Pictures (" mrowse.. -— Select the destination

folder.

Sort Folder Settings:

Based on the following settings, a new folder is created, and
the images are sorted by each of their shooting dates.

Folder Name: [YearMonthDate } ;.]7 Select the name assigned
New Name: 4 € Edit... b to the fOIder Created
during sorting.
:2006_03_09
Use this to add a prefix to
Copy/Move Images Setting the folder name.
® Copy Sample of the name of
Om the actual folder that will
) Move
be created.
( cancel ) ( <Back ( 0k b,

Select [Copy] to retain the file in its original location
or [Move] to shift it to the new location.
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EXPLANATION
When [The files will be organized by Star Rating.]

is Selected

Organize by Star Rating

The files will be organized by star Rating.

Copy/move files with the following star rating.

P Select the Star Ratings of the
O Yrvedr images that will be copied (or
moved).

Copy/move files to the following folders.

Macintosh HD:Users:XXXXX:Pictures

( srowse.. -——— Select the destination folder.

Copy/Move Images Setting

@ Copy

Select [Copy] to retain the file in
its original location or [Move] to
shift it to the new location.

() Maove

Cancel ) ' < Back ( 0K )
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Renaming Images (1/2)

This section describes how to rename images.

PROCEDURES i
Renaming Images

1.

rename.

Click the name of the image that you want to

After a moment you can type the new name.

Type the new name and press [return] key.

Browser Window

£
IMG_0001.JPG I IMG_0002
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|
[L---Pre\r‘zew- | List TimeTunnel | I
w Basic Information E
File Name: IMG_0002
= alr
Muodified: Sat, Sep 9, 2006
File Size: BBE K. Browser Window
Image Size; 1600 ( - T T )
Data Type: PG { Preview | List | TimeTunnel \——
Sound: o) v Basic Information
otk = File Name: IMC_0002
w Star Rating Modified: Sat, Sep 9, 2006
s File Size: EES KB
Lo Image Size: 1600 % 1200
Data Type: PG
Sound:
Lock: -
w ar Rating
T =
<
- CAmMmant b
|
IMG_0003.JPG IMG_0004.JPG IMG_|
IMG_0001.JPG | Pink Flower| IMG_0003.JPG IMG_0004.1PG IMG_0005.1PG
- _ Talm
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Renaming Images (2/2)

PROCEDURES . . . PROCEDURES .

Changing Multiple Image File Names @) Renaming Folders

You can rename multiple image files at once. 1_ In the Explorer Panel, click on the folder name.
9. Select the images you wish to rename in the Browser After a moment, you can type the new name.

Area.

2_ Type a new folder name and press the [return] key.
2_ Click the [File] menu and select the [Organize Image]
submenu, followed by [Rename].

The renaming settings Rename
window will display.

Select the post-conversion file name type.

3. Set the options in this 8 Copy Image Place a check mark here if you wish a file
window and click [OK]. T — with the new name to be created
. . . separately from the original file.
The image file names will O Shiating Date + Nl
Change ) New Name + Shooting Date + Number Se|GCt ahame format'

:'-Shooting Date + New Name + Mumber

New Name: New Name ¥i Type the text in the “New Name" spot for
the name format selected above.
Number;
precitzumberofiigis & S Set the Number of digits and the starting
Specify a Start Number 1 number for the name format selected
above.
Example:
New Name_001 Sample of the name of the actual folder

that will be created.

(The same extension as the original is entered in xxx)

( cancel )| o)
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a Camera Connected

You can search images using such criteria as Star Ratings, shooting

dates, keywords or comments.
REFERENCE

e For information about Star Rating settings, see the Setting Star
Ratings and for information about keyword settings, see the

Assigning Keywords in this chapter.

N

Select a folder to search in the Explorer Panel section.

Click the [File] menu and select [Search].

The search criteria settings window will open.

Set Search Criteria

Specify Search Folder:XXxX:UsersXXXX:Pictures

® Match all conditions ) Match any conditions
» [l Favorite photo

» [Date

» [ Keyword

» [ Comment

ImageBrowser Software User Guide

———————
Browse... )
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3.

Chapter 5

Organizing Images

Chapter 6

Using Supplementary
Features

Appendices Index

Set the search criteria.

Place a check mark beside your chosen criterion and set its
individual settings.

Set Search Criteria

Sets whether images
are searched
according to all the
parameters or just
one.

Clicking here allows
you to hide the
search parameters.

Specify Search Folder:Macintosh HD:Users:XxXXX:Pictures
= e —~ . il
£*) Match all conditions {_ Match any conditions
v E Favorite photo

Images with the following star ratings will be searched for.
v Date
Searches using shooting date. Files without a shooting date are searched
for using modification date.
Start Date: O | 9/12/2006 -
End Date: O | 971272006
It may take some time to search by shooting date if there are a large
number of files.
¥ | Keyword
Searches by keyword added.
People _ Places _ Events Others
] Family 1 Home [ Party
"] Children [l Beach I Holiday
] Friends I city [l Birthday
[P (= TG
You can add a keyword to the image in the Image Properties window or "
in the Preview mode.
———v [ ]Comment
Searches for images using comments attached to the image. :
v
( Cancel ) € searchNow )
Set the search parameters here.
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Searching Images (2/2)
4.

Click [Search Now] when you finish setting the crite-
ria.

A list of images found by the search will display.

Check the search results and click [Finish].
To reset the search criteria, click [Back] and repeat steps 3-4.

S.

Search Results

34 images found.Click [Finish] to return to the Browser window.To review search criteria,

click the [Back] button.
- 2 1

IMG_0D01.JPG IMG_OD0Z.JPG IMG_0D0T.JPG IMG_ODOZJPG IMG_DO03.JPG  IMG_D004.JPG  IMG_D005.JPG
1 1
- E m" m" “3’91

IMG_0006.JPG  IMG_D007.JPG  IMG_D00B.JPG IMG_D00D1.JPG IMG_0001.JPG IMG_0D002.JPG IMG_D003.JPG
s

ﬁ

IMG_00D04.JPG  IMG_0D05.JPG IMG_0DD06.JPG  IMG_OD07.JPG  IMG_D001.JPG IMG_ODOZ.JPG  IMG_D0D03.JPG

IMG_0004.JPG  IMG_00D05.JPG  IMG_00D01.JPG  IMG_0D02.JPG  IMG_0003.JPG  IMG_0004.JPG  IMG_0D05.JPG
" =

IMG_D001.JPG  IMG_0D00Z2 JPG  IMG_DO03JPG  IMG_OO04.JPG  IMG_DODS JPG  IMG_DD06.IPG

F

! ."‘
w e

m
n
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This concludes the search.

When you click [OK] in the confirmation dialog, the “Search
Results” folder is created in the Explorer Panel section and
displays the images matching the search criteria.

®eo0e Browser Window
Folder [ Preview | List = TimeTunnel
Favorite | All - - ..gl

= Last Acquired Images
|| < &4 Shooting Date
& 2006_09_11
[E 2006_09_12

‘I
| l R Search Results

< [& Pictures
[7 2006_09_07
[ 2006_09_08
[ 2006_09_09
[7 2006_09_10
[§ 2006_09_11
[§ 2006_09_12

e The original image will also be deleted when you delete an
image from the Search Results folder.

REFERENCE

* You can select, print or copy the images in the Search Results
folder to another.

e Images will remain registered in the Search Results folder until
you close ImageBrowser or perform another search.
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Moving and Copying Images (1/2)

This section describes how to move and copy images between folders.

PROCEDURES
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REFERENCE

* Moving or copying images in ImageBrowser affects the actual

location in which those images are stored on your computer.

* \When you use the Finder to modify files or folders while
ImageBrowser is open, those changes might not be reflected in
the ImageBrowser window. To remedy this, click [Refresh] on

the [View] menu.

Moving or copying in the Explorer Panel Section

When you want to move an image, you first need to display it
in the Browser Area. Then, drag that image to the destination
folder in the Explorer Panel Section.
When you want to copy an image, proceed as above, but press
and hold the [option] key before releasing the mouse button to

drop the image.

You cannot drop
images in this area.

Chapter 5
Organizing Images

8ene

Chapter 6

Using Supplementary
Features

Browser Window

Appendices

Index

Folder |

—| Favorite | Al |

- Last Acquired Images

# Shooting Date
3] 2006_09_11
3 2006_09_12

8ene

44 Canon Camera
(3 Movies
= [# Pictures

|7 2006_09_07
| 2006 09 08

i 2006_09209,
[ 2006_09_10
[§ 2006_09_11
|§ 2006_09_12
|7 iPhoto Library

{ Preview | List TimeTunnel |

File Name.
Modified:

File Size:

Image Size

Data Type:
Sound; ol
Lock: D

 Basic Information
IMG_0001
Sat, Sep 9, 2006

556 KB
1600 x 1200
PG

 Star Rating

:@
-
a

@ Drag the image that you want to move.

— @ Drop it at the desired location.

Browser Window

Folder |

————{ Favorite
- Last Acquired Images |

Al -

74 Shootihg Date
& 20p6_09_11
&) zoFs_ns_w 2

g## Canon Camnera

‘ [## Movies
| = [# Pictures
| ¥ z006409_07

[ zoo6 J09_o8
_Ud_UY

{ Preview | List TimeTunnel |

File Name:
Maodified:
File Size
Image Size
Data Type.
Sound

 Basic Information

IMC_0001
Sat, Sep 9, 2006
556 KB

1600 1200
IPG

Lack: —

w Har Rating

(ot B

a

7 2006_09_10
§ 2006_09_11
2006_09_12
7 IPhoto Library. -
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Moving and Copying Images (2/2)

PROCEDURES

Moving or copying images using two Browser Windows

You can display a second Browser Window by clicking [New
Browser Window] on the [View] menu.

You can move or copy images between folders by displaying

. . . . HINT
different folders in two Browser Windows, then dragging
images from one Browser Window to another.
. . o
The First Browser Window
8eoe Browser Window
—@' = —% + Basic Information
- Last Acquired Images File Name IMC_0001 |
+ i shooting Date Rt Modified: Sat, Sep 8, 2006 m
[E] 2006_09_11 File Size 556 KB
3] 2006_09_12 Image Size 1600 1200

4 Canon Camera I

[ Movies
= [# Pictres
(7 2006_09_07
[(# z006_09_08
¥ 2006_09_09
[ 2006_09_10
[§ 2006_09_11
[ z006_09_12
[ [¥ iPhoto Library

MG_0001.1PG

Data Type JPG
Sound

Lock:

(]

o Star Rating IMG_D001

Fri, Sep 8, 2006
1.1 MB
227231704

IFG

DRI —
—
|

i 1MG_0002.PG IMG_0003.JPG IMG_0004.JPG MG_ogpsHPG | = -
-

Vieh [ il v‘|.—.e.—— a @\| Selecting Images ‘
[F ] Y (R

=
=
—

p—

The Second :
Browser
Window
(Display a
different folder)

» = s =

nnnnnnnn - Print - Ll
IMG_0005.JPG
No. of Images Selected: 1 / Totak: 7 images /& =

w
"!' _ -
View | iF Pt ]| =) 2, B[ e smse ||| G

@ Drag the image that you
want to move.

ImageBrowser Software User Guide

= E
& D 3 3
SlideShow Internst - Print - nd to Trazh

M. of Imag

@ Drop it at the desired
location.

Chapter 5 Chapter 6
Organizing Images Using Supplementary ~ Appendices Index
Features
REFERENCE

e To copy an image, press and hold the [option] key before
releasing the mouse button to drop the image.
e Up to two Browser Windows can be open simultaneously.

Other.Methods

Moving or Copying Multiple Images

You can move or copy multiple images at once. Select them by
pressing and holding the [shift] key or [§8] (command) key, or
the [option] and [shift] key together while you click on
successive images and then drag and drop them in this state on
the destination.

Moving or Copying Folders

You can move or copy folders one at a time by dragging them
in the Explorer Panel section on top of another folder and
dropping them.

Duplicating Images

To duplicate an image (copy the same image file within a single
Browser Window), select the image in the Browser Area, click
the [File] menu and select [Duplicate].
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Deleting Images

This section explains how to delete images and folders (send them to
the Trash).

PROCEDURES _
How to delete an image

Select an image in the Browser Area to delete.

Click the [Send to Trash] button in the Control Panel.

1.
2.

Select an image to delete.

- L}i Pictures e
[7 2006_09 07 AN \
(7 2006_09_08 {
¥ 2006_09_09 ¥ Comment
[ 2006_09_10 5
[# 2006_09_11 |5
[§ 2006 09 12
[ [-# iPhoto Library
BeMG_0002. IPGIMG_0003.JPGIMG_0004. JPGIMG_0005. JPGIMG_0006.JPGIMG_0007.JPG
e o—Fa 4| E
o o [ s |~ & I e
Favorite 3 g = a8 3 |
) = = ] = 3
Canon Camera Yiew Imags SlideShow Internet Print. w || Send o Trash
No. of Images Selected: | /l(ma\:?mages 7
Click here.

.........................................

e |f you mistakenly delete an image, retrieve it by double-clicking

the Trash in the dock to open its window and dragging and
dropping the file onto its original folder (in the Finder window
not in the Explorer Panel section).

ImageBrowser Software User Guide
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1.
2.
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Deleting Folders

Select the folder in the Explorer Panel section.

Click the [Send to Trash] button in the Control Panel.

IMPORTANT

-----------------------------------------

* \When you delete a folder, all its images and subfolders are
deleted too.

Other Methods

Sending Multiple Images to the Trash

You can send multiple images at once to the Trash. Select them
by pressing and holding the [shift] key or [§8] (command) key,
or the [option] and [shift] key together while you click on
successive images and then click [Send to Trash].

Using the Menu to Send Images to the Trash

Send images to the Trash by selecting them, clicking the [File]
menu and selecting [Send to Trash].

REFERENCE

* To completely delete the images or folders from the disk, after
these procedures click the [Finder] menu and select [Empty
Trash].
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Rotating Images

This topic explains the procedures for rotating images.
Movies can also be rotated.

PROCEDURES i
How to rotate an image

7. Select the image.

X E

DDI.JII’.G MG_0002.JPG IMG_0003.JPG  IMG_O004.JPG  IMG_0005.1PG

IMG_O

Click the [Edit] menu and select [Rotate Image].
The rotation settings window will display.

Rotate Image

Set the rotation direction and angle and click [OK].

If the image has shooting
information, the Rotation
Information is added to the
shooting infermation.

E‘.& 90 degrees right

5 90 degrees left
ﬁ 180 degrees

For images that don't have

Selects the direction and
angle of rotation.

image is rotated.

shooting information, the actual

Place a check mark here to ——— Z rotate actual images
change the orientation of
the image data itself. (Still

to the shooting information.)

(The actual image is rotated instead of adding Rotation Information

images only)

ImageBrowser Software User Guide
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A symbol similar to that at the right will
display for images that are rotated in
the display only. The image data itself is
not rotated for these images.

REFERENCE

------------------------------------------

* You can rotate the original image to match the orientation of
the displayed image by clicking the [Edit] menu and selecting
[Rotate According to Rotation Information] (Still images only).

e If a movie cannot be rotated this way, click the [Edit] menu and
select [Edit Movie] to set the direction of rotation.

More ways of rotating images

Rotating multiple images

You can rotate multiple images at once. Select them by pressing
and holding the [shift] key or [38] (command) key, or the
[option] and [shift] key together while you click on successive
images and then perform the rotation procedure.

76 Back Next



Chapter 1 Chapter 2 Chapter 3 Chapter 4 Chapter 5 Chapter 6

Table of What is Downloading and What You Can Do with Viewing Images Organizing Images Using Supplementary ~ Appendices Index
Contents ImageBrowser? Printing Images a Camera Connected Features

Viewing Image Information (1/2)

You can click images and look at the various shooting information REFERENCE
aboutthem -...-.... ................. ...-.‘.. ............
e \WWhen an image taken by the camera is modified and saved by
PROCEDURES . . . . another program, information about the camera settings might
How to view image information be lost.
e |f you select multiple images and display the File Information
9. Setthe display mode to List or TimeTunnel, and select dialog box, clicking [Back] and [Next] switches between the
an image in the Browser Area. information for the images in the selection.

2. Click the [File] menu, and select [Get Info].
File Information dialog box will appear.

The File Information dialog box

contains such information asthe 7 Youcan o e o et o cuch
N - - - ile Informatio )
camera model, the date the image — G Ry J
was shot, and the camera settings ) ﬂ Set a Star Rating
at the time of shooting.
w Comment |
I N r .l |
Hides the detailed information display at the right. ‘ . Inputa comment.
( Hide Eletail ' il :
|
You can rename files. Dgetine: _ gMEsp00l = R :
Modified: Sat, Sep 9, 2006 9:52 AM & View/Modify Keywords... i Set a keyWOfd
File Size: 580 KB
You can play sounds if they are attached IageSioe: l 1500 1200 | Brightess Histogram E
. Data Type: PG
to images. sons. 4 E
Lorke j : Histogram
Placing a check mark here prevents the ;
image from being overwritten or deleted. | i
D H
 Shooting Information Shooting information shown here will
_ o _ Fom Hame Vatae vary according to the camera model and
_You can view the shooting |_nformat|_on for the - —_— - Flelame e bnOODLIPC image shooting settings.
Image before or after -the dISplayed |mage. L < Back 5 Next > ] Shooting Date /T irme 03/0%/06 0%... b4
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Viewing Image Information (2/2)

PROCEDURES o _ _
Viewing Information in the Viewer Window

Shooting information will display on top of the image when
you click the [Show Information] menu and select [Show
Shooting Information] when an image is displayed in the

Viewer Window. Shooting Information

086 L4 IMG_0001JPG

« » | B & Hom @ = ~
Back Mext | Save

Edit w  Displays ~ Synchronize Full Soreen Frint Show Information -

Display Size: 1600 x 1200

ImageBrowser Software User Guide
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Creating Folders

This section describes how to create folders within disks or other folders. REFERENCE
PROCEDURES * See the Renaming Images (2/2) for the procedures for renaming
How to create a folder folders.
* See the Deleting Images for the procedures for deleting folders.
1_ Select the disk or folder in which you wish to create * When you create a new folder in ImageBrowser, a new folder of
the new folder. the same name appears in the Finder.
re 0 6 .= Pictures =
Folder Q- e
—{ Favorite | All ! J
- Last Acquired Images 2008,09.07 zUC:;:’D’E s 2006.00.09
<  Zi shooting Date . =
] 2006_09_11 g L L*
E 2006_09_1 2 i 2006_09_10 20060911 2006_09_12
2 Canon Camera ,mgm um;,;f,,,,
[& Movies eoe
< [ Pictures Folder
7 2006_09_07
[7 2006_09_08 } —— [ Favorite T Al | T VR it =
[ 2006_09_09 e & Last Acquired Images
< 24 Shooting Date New Folder
. . 3 2006_09_11
2. Onthe [File] menu, click [New ‘ A 2006_09_12
Folder]. ‘ =
: , A Canon Camera
A new folder called [Untitled Folder] will [ Movies
be created. v [p2

[ Untitled Folder
T 2006_09_07 |
[ 2006_09_08
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1 Appendices

Editing Images (1/10)

This chapter explains the methods for handling images managed by
ImageBrowser.

This section explains the procedures for editing images displayed in the
Viewer Window.

EXPLANATION .
About the Editing Features

You can perform the following editing procedures if you click
[Edit] in the Viewer Window.

a

Trim Image...
i Color/Brightness Adjustment...

Red Eye Correction...

Insert Text...

Level Adjustment...

Tone Curve Adjustment...

Sharpness...

Auto Adjustment...

Edit with Registered Application >

=

Hurber of
R

4

Back

4

Mext

£

A

Ey

Display Size: 1600 x 1200

XHOXHHKKXK

Trim Image

You can extract part of an image, leaving out parts that you
don’t need.

Color/Brightness Adjustment

Use this to change image appearances by adjusting the RGB
(red, green, blue) intensity, saturation and brightness.
Red-Eye Correction

Use this to correct images in which peoples’ eyes appear red.

Insert Text
Use this to place text on the image.

ImageBrowser Software User Guide

Level Adjustment

Use this to adjust the levels in an image to change its
appearance.

m Tone Curve Adjustment

Use this to adjust the tone curve for an image to change its
appearance.

Sharpness

Use this to emphasize and clarify the outlines of people and
objects.

» Auto Adjustment
Use this to automatically correct the image color balance.

Edit with Registered Application
See the Editing Images with Other Software.

Detailed explanations of these procedures start on the next
page.

IMPORTANT

ooooooooooooooooooooooooooooooooooooooooo

e These editing procedures cannot be used on RAW images or
movies.

REFERENCE

® You can also edit images by clicking the [Edit] menu and
selecting another image editing program from the [Edit with
Registered Application] submenu.
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Editing Images (2/10)

PROCEDURES _ .,
Trimming

Use this to delete unnecessary portions of the image and leave
only the necessary portions.

oy

1.

Click [Edit] in the Viewer Window and select [Trim
Image].

The Trim Image window will open.

2.

Position the mouse pointer over the image and drag
it to select the trimming area.

Drag to specify the

You can also specify the
trimming area.

trimming area with numbers.

Trim Image

Trims the displayed image
After specifying the area yi
and drop,

click the Trimming button.

u want to trim using drag

Chapter 5 Chapter 6
Organizing Images Using Supplementary Appendices Index
Features
0000

Click [Trim Image].
The specified area is trimmed.

Check the trimmed image and click [OK].
This completes the trimming procedure.

Use this to reset the specified area.

Trim Image

Trim settings:

Lacation (top-left corner)

x| E |

¥:|138
I Size of Trimming area:

W 1352

H: 980

Fit to window @ Q Q
: Undadd

Trim Image )

(—— ) =

z1"§k'7 4

Display Size:

1600 x 1200

Display -

You can adjust the trimming

Trims the displayed image.

After specifying the area you want to trim
and drop,

click the Trimming button.

using drag

Trim settings:

Location (top-left corner)

X:

Size of Trimming area:

W

(

Undo ) \

Trim Image

You can change the
area by dragging the corners or display magnification.

Click this button.
center points of the sides.

Di:

ImageBrowser Software User Guide

splay Size:

( Ccancel lG—H|

4

1352 x 980

Display - 5%
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Editing | (3/10)
PROCEDURES

Adjusting Color and Brightness

Use this to adjust the RGB (red, green, blue) intensity, saturation
and brightness of an image.

1_ Click [Edit] in the Viewer Window and select [Color/
Brightness Adjustment].

The Color/Brightness Adjustment window will open.
2. Use the sliders to adjust the color attributes and then

click [OK].
] ] This button switches between adjustment dialogs.
RGB Adjustment Window _ _
Color/Brightness Adustment c°|or AdJUStment Wlndow
Color/Brightness Adustment
[RGB Adj | Color Adjustment -
! RGE Adjustment | Color Adj |
Red 1 ||
Saturation | ‘ I-'G T 0 g
Green - 8 1] z\‘
‘ . o ‘ Brightness *@ i i 0 3
Blue : ‘ : \vi — 0 8
] Show Original Image k Undao All ) E Undo ) Red i
1 Show Original Image k Undo All ) E Unde ) ( Redo
)
Dispify Size: 1600 x 1200 I [_! ( Cancel ) 6—w—‘9
Display Size: 1600 x 1200 ]

You can use this button to compare the pre- L——— Clicking [Undo All] restores the image to the state before the adjustments.
adjustment image and the post-adjustment Clicking [Undo] reverses the action taken immediately prior.
image by placing a check mark here. Clicking [Redo] restores the action cancelled by clicking Undo.

ImageBrowser Software User Guide
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PROCEDURES ] ® Manual Mode
Red-Eye Correction
_ . 1 Select [Manual Model].
This corrects the red portion of eyes that appear red. "
Click [Edit] in the Viewer Window and select [Red-Eye 2. Move the mouse cursor over the red portion to
Correction] to open the red eye correction window. highlight it and click to start correcting.
3 Click [OK] when it finishes correcting.
= Auto Mode :
1_ Select [Auto Mode] and click [Start].
Red eyes will automatically be corrected.
2 Click [OK] when it finishes correcting. Select this to choose You can change the
" You can compare the pre- manual red eye correction. display magnification.
correction image and the - L S
post-correction image by pp— P —
placing a check mark here - =
and having the pre- ® Manual Mode
correction image appear.
Select this to have it automatically
perform the red eye correction.
Red-Eye Col’mnion
éAulo Mode l E '
OManuaI i ——————_| Show Original Image [_ﬁ[ w\,':ilr":f):! ‘_:] k-llgni Redo

ImageBrowser Software User Guide

Click [Undo All] to restore the image to its pre-correction state.
Click [Undo] to cancel the action immediately preceding.

Click [Redo] to reinstate an action canceled with the Undo button.
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PROCEDURES 3
Insert Text =

Use this to place text on the image.

Click [Edit] in the Viewer Window and select [Insert
Text].

The Insert Text window will open.

1.

Move the mouse cursor over the image and click
where you would like to place the text.

4.

Insert Text

Input text and set the font type, size and other
attributes.

Click [OK].
This completes the text input process.

REFERENCE

* You can move the text frame by dragging it.
® You can change the text frame size by dragging the corners or
mid-points on the sides.

Dragging (or clicking) on the
window displays a text frame.
Next, input the text into the
box at the right.

[_1Show Original Image

You can compare the pre-
correction image and the post-

Font Name:

Font Size:

Text Color:

Text Attribute:

| Geneva )‘E'i

=% Sets the font, font size, text color and text
[ ] attributes.

[B]

™ Antialias

Place a check mark here to have the

Text:

text edges blend into the image.

In the Park

Import Comment

Import Shooting Date/Time )

Inserts comments attached to the image

or the shooting date/time.

| Fit to window W a Q |

[f\.ludo All

Undo Redo ]

You can change the display

correction image by placing a
check mark here and having the
pre-correction image appear.

|Display Size: 1600 x 1200 |

( cancel fC ok ) magnification and display area.

Display: 23% ]

Click [Undo All] to restore the image to its pre-correction state.
Click [Undo] to cancel the action immediately preceding.
Click [Redo] to reinstate an action canceled with the Undo button.
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00000
Editing | (6/10)
PROCEDURES Selects the Auto adjusts
Adjusting Levels channel to adjust. the levels.
You can adjust an image’s highlights (brightest portions), Histogram
shadows (darkest portions) and mid-tones while viewing its
. Level Adjustment
h|5togram. [ RrcB ) Auto Levéls

Input Levels 255

o] 100

1_ Click [Edit] in the Viewer Window and select [Level & preien
Adjustment].
The Level Adjustment window will open. y s

2. Adjust the levels and click [OK]. | "o L (o —————=38

Use Last Applied Settings

[( undoAll ) ( Undo 3 Redo

cancel | @0k

Display Size: 1600 % 1200 P

Adjusts the post-adjustment —
shadow and highlight levels.

Use this to repeat the
same adjustment.

Click [Undo All] to restore the image to its pre-adjustment state.
Click [Undo] to cancel the action immediately preceding.
Click [Redo] to reinstate an action canceled with the Undo button.

Adjusts the image shadows (darkest portions),
mid-tones and highlights (brightest portions).
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Editing Images (7/10)

PROCEDURES Selects the channel to adjust.

Adjusting Tone Curves : .
Click on a point to
You can adjust image brightness and color balance using a tone alter the tone curve.
curve (a revisable graph plotting the input and output
brightness data). The tone curve allows for more subtle e
adjustments. ol B —
9. Cdlick [Edit] in the Viewer Window and select [Tone LR e |0 =

Curve Adjustment].
The Tone Curve Adjustment window will open.

2. Adjust the tone curve and click [OK].

____________________

,,,,,,,,,,,,,,,,,,,,

£ Use Last Applied Settings )
R . =
* You can delete a point on the curve by selecting it and pressing el | @0
the [delete] key. o | il 7
Use this to repeat the
same adjustment.

Click [Undo All] to restore the image to its pre-adjustment state.
Click [Undo] to cancel the action immediately preceding.
Click [Redo] to reinstate an action canceled with the Undo button.

Displays the pre-
adjustment image.
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ROCEDURES

Adjusting Sharpness

Use this to emphasize and clarify the outlines of people and

objects.

1_ Click [Edit] in the Viewer Window and select

[Sharpness].

The Sharpness window will open.
2. Adjust the settings and click [OK]. Sets the magnitude

" of the effect.

Sharpness

o [

[( UndoAll ) ( Undo ) Redo ]

DiSp|ayS the pre- ——————— | Show Original Image

adjustment image. e [m]

Display Size: 1600 x 1200 i

Click [Undo All] to restore the image to its pre-adjustment state.
Click [Undo] to cancel the action immediately preceding.
Click [Redo] to reinstate an action canceled with the Undo button.
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Editing | (9/10)
PROCEDURES .
Auto Adjustment

Automatically adjusts the image color balance and brightness.

Click [Edit] in the Viewer Window and select [Auto
Adjustment].

The Auto Adjustment window will open.
Click [Auto Adjust Image].

Auto Adjustment

RS

Auto Adjust Image )]

Undo

| Show Original Image
T

Disglay Size: 1600 x 1200 A

Displays the pre-adjustment image.

Click [OK].
This completes the auto adjustment process.
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Click [Undo] to cancel the action
immediately preceding.
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0000
Editing Images (10/10)
PROCEDURES . REFERENCE
SAVINGIMAGES el

o . e [f you do not save the image after editing and close its window,
Save the edited image under a different name. a confirmation dialog will display to confirm whether or not you

1. After you modify an image, click [Save]. wish to save it.

| Fit to window M Sy l:i

- K'T Before quitting, would you like to save the changes
) -
4 3 L& & = =i = -~ N to IMG_0001.JPG?
MNumber of —— : o Aﬁ
Back Mt Save Edit - Dizplays = Synchronize Full Screen Frint
—_——
Display Size: 1600 x 1200 Dis ( Don't Save ) [ Cancel

The file save dialog box will appear. . .
To save the changes, click [Save]. In the save dialog box, type a

2, Type a file name, specify the image type and click name and specify the image type that you want to use. Then,
[Save]. click [Save].
If you do not want to save the changes, click [Don’t Save].
e Exif JPEG is an image type that adds information such as

Save As: IMG_0001 f+] , . ) .
== + shooting data to a JPEG image. This data can be handled in the
W e 2 same fashion as conventional JPEG images.
Image Type: Exif JPEG I—:i
e

To overwrite the original with the edited image, you can use
the file save dialog box to input the same file name as the
original and save the file.
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Editing Images with Other Programs
You can edit the selected image with another image editing program if PROCEDURES ) o
it is registered with ZoomBrowser Ex. % Starting an Image Editing Program
PROCEDURES 9. Click [Edit] in the Viewer Window, select [Edit with

Registering Image Editing Programs Registered Application] and select an editing program

1_ Click the [ImageBrowser] menu and select from the submenu.

i : EH &t ~ '
[Preferences]. Select [Browser Window] from the | B‘k N’t = 4 ’:| | = = =
pulldown menu and register the program in the el e 1a00 Sane = |
[Register Application] area. Red Eye Correction...
Insert Text...

Level Adjustment...

Preferences
Tone Curve Adjustment...

! i Browser Window f H ] i ;:?(r)p;;;j;t.ment.‘.
- E Edit with Registered Application » OO
Thumbnail Area ) @
Frame Color [ Selection Color = i
Background Color —1
== Registered program names display here.
e T — | The image editing program starts and displays the selected
——DfCropse Lustarm loon for imanes 5 image.
Register Application |
s I i i
— REFERENCE
LL’ I . L s s s s s 6 6 o o o o o 5 o 5 s 6 6 0o 0 0 o o o 5 5 o 6 6 0 e e s o o s s s s e o o
5 Delete * You can also start image editing programs by clicking the [Edit]

menu and selecting another program from the [Edit with
Registered Application] submenu.
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Creating Images for E-mail (1/2)

This section explains how to create email with image or movie 4 Click [Next].
attachments. The Create Image for Email dialog box appears. (However, if you
PROCEDURES selected the “Send without changing the file size” option, the
% How to send an image by e-mail Send Email dialog box appears and you can proceed to step 7.)

_ Specify the reduction ratio and the image quality.
9. Inthe Browser Area, select the image that you want 5. Specfy geq y
to send. Use it to check the file size when you actually compress the image.

. (The file size appears in the Total Size After Compression category.)
You can also select several images.

RAW images cannot be attached. Specify the reduction ratio relative to the original size of the image.
2_ Click [Internet] in the Control Panel and select [Create Click here to preview how the image will appear after.
Image for Email]. Create Image f¢r Email

Set the still image and movielcompression settings, click [Compress]and check the image size,
After setting the compressiof settings, click [Mext] arld go to the next step.

3_ Specify the compression method that you want to

app |y to the ima ge Total Sizelefore Compression |
.
File Count}: 1 Total Size After [Compression : SE0KB
Compresgsettings _— =
Create Image for Email still Imagle Settings
You can create a image appropriately sized for sending via e-mail. . . = r---'— =) _
You can also send the image without compressing it. Te send the image without compressing it, Use thls Opt|0n When Resize®) | 100 L Quality =
select [Send without changing the file size]. To send a compressed image, click [Resize, comprass, s nglh
and send], you do not want to : z s
After making your selection, click [Mext] and go to the next step, . (_ Compress ) (_ Preview ) J Compressed still image total sfze : OKE
reduce the size of the —
. _Idovie File Settings .
|mage Image Quality Settings @) priginal Image Quality
7 Send without changing the file size ) Low Image Quality (Size: 160x120 Frame Rate:8fps)
{® Resize, compress, and send ), Use thIS Optlon When Play Time @ Original Time
uick Play (5 seconds
you want to reduce . DU Ay e
Compress Compressed movie file total fize :0KB

the size of the image.

Selacted File Information

Total Size After Compresdion : OKB

Still Image Count : 1 still Image Total Size : 556 KB
Movie Image Count : 0 Movie Image Total Size :0 KB . . (» Ganaa ) { < Back 3
Total File Count = 1 Total size : 556 KB Conflrm the total Size !
of the file for : . . . ,
In general, it is recommended to keep the total size less than 300KB. transmission here_ S.et the Image quallty an.d play SPECIfy the Image q.uallty'
time here to send a movie. (The lower the quality, the rougher the
(== (- Nexts - image becomes, but the size of the file

also becomes smaller.)
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Creating Images for E-mail (2/2)

6.
7.

Click [Next].

The last window appears.

Save the image and select whether you want to start
your e-mail program.

Save the image and place a checkmark here
if you want to start your e-mail program.

| Create Image for Email

Click tHe [Finish] button, The image for attaching to an email message will display in the Browser
Window, Attach this image to your email message.

@ jart email application after closing

[ Warning! File is too big. Resize or compress the file hefore sending it. ]

Compresged file information

Still Imagp Count : 1 still Image Total Size : 492KE

Movie Imige Count : O Movie Image Total Size : OKB

Total File|Count : 1 Total size : 492KB

Preview )

( “cancel ) (<Back ) (] Finish—)

Click here to check an
image after changing it.

A warning message displays
when the file size is large.

Click [Finish].

e |f this is the first time you send an image in e-mail, the [Email
Images] folder appears in the Explorer Panel Section, and the
image is saved in that folder. If the [Email Images] folder
already exists, the image is saved in that folder.

8.
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e \When you click [Finish], your e-mail program starts
automatically if you have selected “Start email application
after closing” in Step 7. Please note that some e-mail
programs may not support auto startup.

e You can send the image you just created by opening a new e-
mail and attaching the image to the e-mail message.

e \With e-mail programs, you can attach images to e-mail
messages simply by dragging them from the Browser Area to
the new message window.

REFERENCE

------------------------------------------

e Changing the Email Program that Starts Automatically
Open the [Applications] folder on the startup disk and double-
click [Mail] within it to start the Mail program. Click the [Mail]
menu and select [Preferences]. Use the [General] tab to select
the program.

e Open the following folders to find the folder containing e-mail
images. On the startup disk open [Users], [your user log-in
name), [Library], [Preferences], [ImageBrowserUserData] and
[Mail].
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Exporting Images (1/3)

This section explains how to change the size, resolution or data type of PROCEDURES

a selected image and write it to a new file, and to export the shooting % Exporting Images

information to a text file.

7. Select the image(s) in the Browser Area.

Export Options You can export a multiple selection of images except when the
Export an Image as Wallpaper option is selected.

EXPLANATION

The following types of image export options are available. , ,
_ I P Je erportop 2. Click the [File] menu and select [Export Images].

= Edit and Save Image A dialog for selecting the export options will open.

You can change the data type or size and the file name and : :

save it. Select one of four data types: JPEG, PICT, TIFF or BMP. 3. Select an export option and click [Next].

You can also add identifying characters to the start of the file Write a still image

name.

. . @ Edit and Save Image

m Export Shooting Properties R e e,

You can select the necessary data from the detailed shooting

information and export it to a tab-delimited text file. O Export Shoot T Proii®

Exports the Shooting properties of the selected image to a file.

m Export as a Screensaver
You can export a selected image as a screen saver file.

() Export as a Screensaver
Creates a screen saver from the image.

u Export an Image as Wa"paper Movie images and RAW images cannot be exported.
You can export a selected image as a wallpaper file.

) Export an Image as Wallpaper

The image will be made so you can use it as Wallpaper.
Movie images and RAW images cannot be used as Wallpaper.

REFERENCE

e Only the Export Image Shooting Properties option can be used 4. Set the export settings.

with movie files and RAW images.
° The procedures from this point onward vary according to the

export format.
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Exporting Images (2/3)

EOLNATON _
Editing and Saving Images

Click [Finish] after specifying the settings.

Changes the Changes the Changes the
image size. image type. image file name.
Edit and Save Image
[_| Resize the image
+) Specify the length dimension 1600 Hixels
: Specify the width dimension 1200 Hixels
[_ Change the image type
New image type IPEG _:
Image Quality Low = \"\_) High
" Rename the file
Initial text
MNEW Sequence number is assigned automatically

Example: NEWOOO1.JPC

Original file size:556 KB
File size lhnuﬂ'"-, sion: (Calculation ) Preview —

Save To: acintosh HD:Users:XXXXX.Pictures:2006_09_09 ———£  Browse... )
( Cancel | ( <Back ) msh—)

Destination Folder

Calculates the post- You can confirm the

conversion file size.

Changes the
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destination folder.  post-conversion image.

EXPLANATION _ _ _
Exporting Shooting Properties

Click [Finish] after specifying the settings.

Place check marks beside the export
categories you want.

You can insert or remove
all check marks at once.

Export Shooting Properties

Select the image info to be written.
Createq a text file in which item names and values are tabtdelimited.

E[ File Name m

] Camera Modal

[] Shooting Date/Time

1 Shooting Mode

] Photo Effect Mode

1 TviShutter Speed)

1 Av(Aperture Value)

1 Metering Mode

) Exposure Com pensation

M Ninital Fvnacura Camnancatinn

I»f

€ Select All 3 € Deselect All )

File Name text

Save To:Macintosh HD:Users:...4:Pictlres:2006_09_09 ( Browse.. ———

A single file is created for 10 images
The file ngme is given a sequence number.

( Cancel )( < Back )(_FWH

You can input a file name. Changes the destination

folder.

Destination Folder
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Exporting Images (3/3)
EXPLANATION

Exporting as a Screen Saver

Click [Finish] after specifying the settings.

Input a screen saver name.

Export as a Screensaver

The selected image|will be exported as a screen saver.

Name of Screen Saver

photo

Save To

Macintosh HD:Users:XXXXX:Library:Screen Savers

( Cancel )( < Back )E Finish

)

Destination Folder
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Index

EXPLANATION _
Exporting an Image as Wallpaper

Click [Finish] after specifying the settings.

Selects a display method for the image.

Set Image as Wallpaper

Sets the image as Wallpaper

Specify Display Method Fit to Screen W'i

C Cancel ,Jk < Back
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Running Slide Shows (1/3)

This section describes how to use slide shows that display multiple
selections of images in sequence at full screen size.

IMPORTANT

* RAW images and movies cannot be shown in slide shows.

PROCEDURES _
Setting up a slide show

First, you need to specify how to run the slide show.

1_ Click the [View] menu and select Slide Show Options
[Slide Show Options]. A A
. . . Auto Pl f
2. Setthedisplay options and click O Aty ‘
" Play Interval €v 1 Sec o
[OK]. _ o ——— Select the "Auto Play” option if you want
: the slide show to proceed automatically
O Control with Mouse or Keypad and go to the next slide after a
Select this option if you want to continue ——'[ JRepeat Continuously predetermlllned number of seconds.
running the slide show when it ends. @Hides e aelect(‘;be glont.rfl with Mﬁlse ort |
eypad” option if you want to contro
Place a check here if you do not wish the the progress of the slide show manually.

Transition Effect

buttons to show while a slide show is in
progress.

Select the transition effect to be used — | [Random 3
when moving from one slide to another.
(When you click an effect, you can get a
preview of how the effect looks in the

area to the right.) @

( Cancel )G—BK-—*

ImageBrowser Software User Guide 96




Viewing Images

Chapter 5 Chapter 6
Organizing Images Using Supplementary | Appendices Index
Features

Chapter 1 Chapter 2 Chapter 3
Table of What is Downloading and What You Can Do with
Contents ImageBrowser? Printing Images a Camera Connected
Running Slide Shows (2/3)

PROCEDURES ]
How to run a slide show

9. Select the images for the slide show in the Browser
Area.

2_ Click [SlideShow] in the Control Panel.
Slide show will start.

e To show all of the images in a folder in a slide showy, it is
convenient to click the [Selecting Images] menu in the Display
Control Panel and select [Select All].
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Slide Show Control Panel

While running a slide show, you can use the control buttons at
the bottom of the window to control the show.

Pause
Back one image Next image

Go to firstimage Advance to lastimage

o]
e 2 @E@ODE @

Stop slide show

- Print Settings Button
You can select an image to print.
After the slide show ends, the image for
which this button was clicked displays in the
print window.

— Select Images Button

You can select images.

After the slide show ends, the image for which
this button was clicked appears in the selected
state in the Browser Area.

Star Rating Settings Button
You can set the Star Rating for an image
while it is displayed.
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Running Slide Shows (3/3)

If you selected “Control with Mouse or keypad” in the Slide Show
Options dialog box, you can control the slide show as follows:

= To move to the next image

Press the [return] or [--3] key.
Click the image.*

m To return to the previous image

Press the [«--] key.
Hold the [shift] key and click the image.*

m To end the show
Press the [esc] key.

REFERENCE

* The operations marked with an asterisk can only be used when
[Hides buttons] has been selected in the Slide Show Options
dialog. (The mouse actions are disabled when the buttons are
displayed.)
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If you selected Hides Buttons in the Slide Show Options
window, you can display the control menu while a show is in
progress by pressing and holding the [control] key while clicking
with the mouse. You can control the slide show with this menu.
(This procedure can also be used if you selected Auto Play.)

Mext
Previous

To Last Image
To First Image

Pause

Quit
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Adding Sounds to Images (1/2)

You can add sounds to your images and play them later.

IMPORTANT

¢ You cannot add sound files to movies.

REFERENCE

* You use the Mac OS X recording function to record
ImageBrowser sounds. Prepare the microphone if one is
provided with your computer, and confirm that the settings are
correct for recording by opening the [System Preferences] dialog
box and selecting [Sound].

How to add a sound to an image

Select an image in the Browser Area.

Click the [File] menu and select the [Sound] submenu,
followed by [Record].
The following dialog box appears.

When you click @, the [Save] button becomes
enabled and recording starts.

PR@ES
1.
2.

3.

|
Cancel ] \
00:00:00 Save ( Cancel )
00:00:10 GE)
>
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To stop recording, click [Save].

The sound is added to the image.
The following symbol appears when an image is accompanied

by sound.

Browser Window

TimeTunnel

E Preview | List

IMG_00017.JPG | IMG_0002.JPG IMG_0003.JPG It

This symbol indicates an image with sound.
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Adding Sounds to Images (2/2)

PR@ES
1.
2.

How to play sound added to an image

Select an image with a sound attached.

Click the [File] menu and select the [Sound] submenu,
followed by [Play].
Sound will play.

You can control playback by clicking [Pause] or [Stop] on the
[Sound] menu.
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REFERENCE

* You can also play sounds by clicking «jj in the Information
Panel when the display mode is set to Preview or in the File
Information dialog box.

e To delete a recorded sound, select the image to which it is
attached, click the [File] menu and select the [Sound] submenu,
followed by [Send to Trash].

® You can record a new sound by selecting an image that has a
sound attached already, clicking the [Sound] menu and selecting
[Record].

* \When you add a sound to an image, the sound file is created in
the same folder as the image file as an AIFF format file with the
[.aif] file name extension.
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Printing Images

EXPLANATION o » Layout and Print
Three Printing Methods This method allows you to lay out the

Vacation Memories

You can select between the following three methods for selected image(s) in special
orinting images. arrangements and add text and
decorations, printing them as one
® Printing One Photo Per Page page in a fancy album.

This method prints one
image per page. You can use
it to print images like photos
with ease. If you select more
than one image, the
corresponding number of
pages are printed.

This method is explained in the
“Layout and Print” topic.

This method is explained in “Printing a Single Image on a Single
Page” in Chapter 2.

® Printing Indexes

This method prints a selection of
multiple images in columns and rows
in an index format.
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Printing Indexes (1/2)
9. Selectimages in the Browser Area.
2. Click [Print] in the control panel and select [Index Selectsa printer.  Selects the papersize  Click this button to switch
Prlnt] from the d|sp|ayed menu. and orientation. between pages if the printout
. . . is more than one page long.
The Index Print window will open.
606 Index Print
IMG_0001.JPG IMG_0002.JPG IMG_D003.JPG IMG_0004.JPG IMG_0005.JPG . )
3 TIC kit Frextew
View "I |s—| | - @, @ | Selecting Images v” & = :xxxxx .H
o Rlagk Lt E Page setup... }
Canon Camnetra Yiew Image SlideShow Internet S e e LA Lo |
MNo. of Images Selected:  / Totak: B images - Orientation:  Portrait
. . Dr] p_rintels_lhat support borderless
3. Setthe categories as desired. B e s ot
" Click [Page Setup] to change this
Sets the number of setting.
print copies. Copies: e
. )
Sets the number of ————— Page Layout Settings i mﬁ =
rows and columns. Rows: 316 = )
Columns:| 2 2

Sets the print settings for

Page Caption Settings I

ShOOting information, = Shooting Information "& Page:1/2 @
comments, headers, footers ( Settings.. )
and page numbers. e s & R il

':e[‘tlr‘lz'] 5. Rotate Left Rotate Right Trim Image

( Close ) C Print )

Rotates images.

Click this to use the trimming function
(crops a portion of the image).
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Printing Indexes (2/2)

4. Click [Print].

On printers that support borderless -
printing, this feature is not _L:"’-“" E*j:-,:v:,.
recommended. o ) —
Click [Page Setup] to change this - )
setting.
Copies: ol
U
Page Layout Settings — mm.__. e -:__‘::n
Rows: 3 .
= [
Columns: 2.
Page Caption Settings —
E Shooting Information "_. Page:1/2 @
]
1 Header | Footer § 2 _:!
Settinq S... Rotate Left Rotate Right Trimn Image

( Close E Print )

#

5. When the Print window opens, click [Print].
Printing will start.
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Layout and Print (1/7)

1.
2.

Select an image in the Browser Area.

Click [Print] in the Control Panel
and select [Layout Print] from
the displayed menu.

The Layout Print window will open.
REFERENCE

e \When the Print window is open, the shooting date and file
name appear as captions under the image when the respective
options have check marks in the Preferences dialog. Click the
[ImageBrowser] menu and select [Preferences], and in the [Print]
category place a check mark in the [Shooting Date] and/or [File
Name] options.

One Photo per page Print...

Layout Print...

No. of Images Selected: 7 / Total: 7 images P

When you select a print style, the print

Select a print style from among the following.
The styles that display will depend upon the printer in use.

Custom layout printing
Allows you to specify the size and location of the images freely.

Fixed photo size printing
Allows you to squeeze images together to fit the specified

paper size. After printing, you can obtain photo-like prints by
separating the images with a cutter.

® Tiled photo printing

Allows you to have the program lay out and print the specified
number of images per page with no gaps between images on
the page.

e a8 Layout Print

Print Preview

| Custom layour printing 1

=

Page setup...

Ad

L. Nakal
image displays in the preview area. pon i
| Fixed photo size printing
8r 8 —
pees | rev 9

[ Tihed photo printing ]

Orientatign:  Landscape

borderless printing on supparted
printers.

Click [Page Setup] to enable ‘

| 2 = %
Page Layout Settings !
N o L
e oo | RGP A |:
—_— 28 X
# Auto Trim ﬁ _ =] s -‘?
Set Photo Area... R B L -
e 1o P

( Cose J( Sae 3  Primt )
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Landscape

ieriap] to enable
rinting on supported

Settings

3R Size

03 inch

"'y;"_' ]
I;!\:s‘f".‘,, Landscape
| .y :.‘ o #

"I "-\h‘

tup] to enable
rinting on supported

.
=1
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4,

Set the page layout.
The settings will vary according to the selected print style.

ane Layout Print
Print Style Preview
[Cosrom ayout printing 5
Printer ! A !
Mame ; :" g b
[ Pty

Paper size Adq

Orientation:  Landscape

Chick [Page Setup] to enable
borderless printing on supported
printers,

Adjust the settings
[ A - in this section (the
: = setting values will
vary according to
the selected print
style).

Lay out the image and text in the preview area.

The layout settings are explained in “Setting the Layout in the
Preview Area.”

a8 Layout Print

Print Styfe Preview

[ Custom tayout printing i e

Printer

[

Paper size . Ad .

e Change the size or
position of images

Click [Page Setup] to enable .

:::.:::I:u printing on supported and Input text.
4
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Click [Print] when you finish adjusting the settings.

When the Print window opens, click [Print].
Printing will start.

IMPORTANT

-----------------------------------------

e Printing may take a long time depending upon the number
and size of the images.

REFERENCE

* You can save the layout you create by clicking [Save] in the Print
window or by clicking the [File] menu and selecting [Save].
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Layout and Print (3/7)

PROCEDURES ® Moving or changing the size of an image

Setting the Layout in the Preview Area When [Custom layout printing] is selected from the [Print Style]
menu, you can move or change the size of an image.
= Adding Images

You can add images by dragging them from the Browser Area
and dropping them into the Print window.

Layout Print

Preview

m Deleting Images

You can clear images from the Print window by selecting them |
and clicking [Clear].

) |

806 Layout Print ‘ Drag the image that
Print Style Preview : you want to move.
[ Custom layout printing F%]

Printer
Name:
[ XXXXX )

{ Page setup... )

Paper size: A4

Layout Print

Preview

- —— ]

Orientation:  Landscape

Click [Page Setup] to enable
borderless printing on supported
printers.

‘ 5J Drag any side of the
— : — = frame of the image
g &/ "= 0 & |2 to change its size.
Rotate Left Rotate Right Trim Image Images Ra-Layout Clear
per Page

( Close ) ( Save ) € Print P

A
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Layout and Print (4/7)
m Rotating Images £ Trim Image The area inside

the white frame is
the trimming area
(portion that will
be printed).

This rotates images 90 degrees left or right.

S —————————————

§ 2| = [ & #

Rotate Left Raotate Right Trimn Irnage Irmages Re-Layout Clear
per Page

m Trimming Images

Trimming is a function that crops a portion of the image. When
the image displays, drag one of the corner or edge points of e  — :
the white frame to set the area to be cropped and click [OK]. To . - Ee=d .,

Drag the corner
or edge points.

move the cropping frame, drag inside it with the mouse cursor. . . o _ _
. — A white dotted line will display if you place a check mark beside
r h . . ) .
& R Sl - e . [The Rule of Thirds]. You will have a balanced composition if
) -— E@ Ha ‘-‘é you position the person or building you wish to make
Rotateleft  RotateRight || Trim image | meges _gResiovpt Glex prominent within the white dotted lines or at the intersections

(white squares).

[A Trim Image

# The Rule of Thirds ™ Trim Image ( cancel ) &0k

Fa
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Layout and Print (5/7)

m Setting the Number of Images Per Page/Rearranging

When [Custom layout printing] is selected from the [Print Style]
menu, you can use the following functions.

§ B |m v & .2

Rotate Left Rotate Right Trimn Irnage Irmages Re-Layout Clear
per Page

|

Specify the number of Click to reorganize the
images that you want images according to
to see on each page. their file size.

m Typing a caption

You can type captions for individual images. Select an image
and on the [Edit] menu, click [Edit Caption]. The Edit Caption
window appears. Type your caption and specify the font and its
size, as well as any styles that you want. Click [OK].

Font (typeface) Font Size Text Alignment

Edit Caption

The location of the caption differs depending on what kind of
print style you have selected.

Custom Layout Example

Layout Print

Preview

Flower

1 Fixed Photo Size Example
2 @ I '!,L Layout Print
Preview

Geneva I:if 36 I:‘ { Ca—)ncel
B[/ |[ul[o e -|m € o« )

Floweﬁ

Font Style Tracking Text Color
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|

( Close ) (: Save :) ( Print )

Eal -
= L, — =
Rotate Left  Rotate Right | Trim Image Images
per Fage
— ————
( Close ) ¢ Save

Trim Image Images Re-Layout Clear
per Page

& =

Rotate Left Rotate Right
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Layout and Print (6/7)

m Typing text
You can type text anywhere you want in the layout.
First, make sure that nothing is selected and on the [Edit] menu,
click [Add Text]. A window where you can type text appears.
Type your text and specify the font and its size, as well as any
styles that you want. Click [OK].

Add Text

™ [=][=][=]

3] 18

B /] uflo 8] |-m

Flower found during Summer Break

(c
QRETETIENES Cancel

¢ )
€ oo )

The text appears in the center of the page.

Layout Print

Preview

Flower

Flower found -durﬁ B

e e Break
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Text surrounded by a frame is called a “text box.” You can
control text boxes as follows:

Moving text boxes
You can move text boxes by dragging them.

Changing the size of text boxes

You can change the size of a text box by dragging its left or right
edge. The number of lines in the text box changes automatically
according to its size.

Editing text boxes

First select a text box and on the [Edit] menu, click [Edit Text]. A
window where you can edit your text appears. Edit your text.
Another way to open this window is to double-click the text box.
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Layout and Print (7/7)

m Typing a header
You can type a page header.
First, make sure that nothing is selected and on the [Edit] menu,
click [Edit Header]. The Edit Header window appears. Type your
text and specify the font and its size, as well as any styles that
you want. Click [OK].

Edit Header

B E]E=

: Geneva 36

lﬂ f i Cancel )
B[ /][T] e [e )] m € o )

SUMMER FLOWERS

The header appears at the top of the page.

Layout Print

Preview

TS |
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m Duplicating images
After selecting an image, click the [Edit] menu and select [Copy
Image] to display the copy dialog. Specify the number of copies
in this dialog and click [OK] to create only the specified number
of copies. (This cannot be used for Index printing.)
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Printing Images over Multiple Pages

This function prints images, such as panoramic images created with
PhotoStitch, over several pages. You can paste the printed pages
together after printing to create one large print.

3.

PROCEDURES . .
Multiple page printing

9. Select animage in the Browser Area for printing.

FB 086 Browser Window
folcer { Preview | List TimeTunnel |
Favorite | All -  Basic Infarmation
- Last Acquired Images File Name: Stich |
= 4 Shooting Date Madified Sat, Sep 12, 2006
3 2006_09_11 File Size: 1.5 MB
E 2006_09_12 Image Size. 678l x 1873

Data Type: IPG
3 Sound
44 Canon Camera Lotk =

[# Movies P e —
= [# Pictures v

[7 2006_09_07 [~ Ferr -+ L

|77 2006_09_08 2

[7 2006_09_09

|7 2006_09_10

[# 2006_09_11

[ 2006_09_12

[ [# IPhote Library

Stitch.jpg

IMG_0003.JPG IMG_0004.JPG IMG_0005.JPG IMG_0006.JPG
Jo—— 2| = as

[ =] RS View | JoF FilterToal
Favorite -
. i k- = -}
@ B e 2
Canon Camera Wiew Image SlideShow Internet - Print - Send to Trash

No. of images Selected: 1 / Total: 7 images | 2

2_ Click the [File] menu and select the [Print] submenu,
followed by [Multiple Page Print].
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Adjust the print settings in the dialog box illustrated
below and click [Print].

Multiple Print

Preview:

ECenter Horizontally

g Center Vertically

| Fit 1o Page
E Print Over Multiple Pages
[ E Print with Overlaps ]

® ( Cancel ) ( Page Setup... )'f—m—a'

Position setting

o —— Sets the overlap for binding.
Printing starts.

REFERENCE

e |f you are going to change the print size, you must make the
change before you print over multiple pages. Open the print
resolution settings window by clicking the [File] menu and
selecting the [Print] submenu, followed by [Multiple Page Print
Options].

The smaller you make the resolution, the larger the image is
printed. Similarly, the larger you make the print resolution, the
smaller the image is printed.

Options
Print Resolution
240 ) dpi
( Cancel ) (—Sﬁﬁ
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Sorting Images by Date and Time - TimeTunnel (1/2)

This section describes how to use TimeTunnel to sort images by date
and time, like arranging images in a time tunnel.

PROCEDURES L. L
Displaying images in TimeTunnel
. . Point at an image and
Select [View Mode], followed by [TimeTunnel] to perform the wait a moment. The

following operations in TimeTunnel display. information about the
image is displayed.

|

Double-click a thumbnail to
display it in another window.

The date/time at which the images were _‘
shot appears on the red line. You can
change this date/time by double-clicking

it on the display. A window similar to the
one below appears. Specify the new
date/time.

Drag this bar up or down to
shift the tunnel display.

Date Settings

] Find and Show Item

Click to display the control
panel menu (the menu is
explained on the next page).

9/ 972006 3]

| Cancel ) f 0K )

If you select “Find and Show ltem”
and no images with that date are
found, the closest match to the date
is displayed instead.

112 Back Next

ImageBrowser Software User Guide




Chapter 1 Chapter 2 Chapter 3

Table of What is Downloading and What You Can Do with
Contents ImageBrowser? Printing Images a Camera Connected

Viewing Images

Chapter 4 Chapter 5 Chapter 6
Organizing Images Using Supplementary Appendices Index
Features
00000

Sorting Images by Date and Time - TimeTunnel (2/2)

EPLANATON
Using the Control Panel menu

The Control Panel menu allows you to control TimeTunnel.
r =y

-

Hiina

‘ Click to display the tool panel.

Displav Tool P | Enables or disables [Auto Cruise].
(= e EE When [Auto Cruise] is active, the time

. movement continues even after you
Auto Cruise

have moved and released the bar.

Play 3 — (lickto play a sound attached to a
selected image.

EPLANATON
Using the Tool Panel

To display the following tool panel, click [Display Tool Panel] on
the Control Panel menu.

Allows you to specify the date for the Select this option to make the

images displayed. TimeTunnel rings octagonal.
o 9/3/06 L
B OO O ODDDD P
&)
{)

Select this option to make the  Allows you to change the
number of TimeTunnel rings.

TimeTunnel look curved.
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HINT
Adjusting settings from the Display menu

On the [View] menu, you can also select the [View Settings]
submenu to adjust the settings.

£ (-_-’ ImageBrowser File Edit Internet  Window Help
New Browser Window

View Mode >

View Settings > Display Tool Panel

Sort » Ring Nos. >

Display > Rings >
Change Viewpoint >

—
Winding Tunnel

Auto Cruise

Slide Show Options...

Refresh 3R

Click the [Change Viewpoint] menu and select [Mouse Click
Point] to have the tunnel end move to the point where you click.
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Playing Sound Files

Sound files recorded with the camera's Sound Recorder feature can be
downloaded like regular image files to the computer. The sound file

symbol will appear on the thumbnails in the Browser Area.

Browser Window

{--Preview"'l List = TimeTunnel |

w Basic Information

File Name:
hodified:

File Size:

Image Size:

Data Type:
Sound: o)

SDR_D002
Thu, Oct 16,
4 KE

AL

Lock: E
w Star Rating
A L
- AMME R it 3
| \1 = N
| | = = | = |
| @) (@) | @ |l
(@ (@A (@) It (@
WAV | WAV WAV | WAV WAV
= =2
SDR_0001.wav SDR_0002.wav SDR_0003.wav = wav SDR_0005.wav
[ —— Y | T T

i ‘._Q_— Q @ “ Selekting mages v” @ @
I i (. 1 I

& 3 "3 =

Canon Carnera Yiew Image Slide Shomes Internet - Frint -

Send to Trazh

Mol of Images Selected: 1 / Total: & images y

Sound File Symbol
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You can play back a sound file by selecting it, clicking the [File]
menu and the [Sound] submenu, and selecting [Play]. During
playback, you can control the playback by clicking the [Sound]
menu and selecting [Pause] or [Stop].

In addition, you can play back a sound file by double-clicking its
thumbnail to start QuickTime Player.

REFERENCE

oooooooooooooooooooooooooooooooooooooooooo

* You can also play back a sound file by clicking the i} button
that appears in the information display panel when the display
mode is set to Preview or that appears in the file information
window.
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Playing Movies

ImageBrowser supports movies.

You can download movie files and display them in the Browser

Area just like ordinary images.

The movie thumbnail and movie icon will show in the Browser
Area. You can play the movie displayed at the larger size by

clicking the controller beneath it.

Use this button to play the movie.

» Browser Window

{ Preview | List

. \
TimeTunnel

v Easic Infarmation
File Name: MVI_1357
Modified:

)
Wed, May 11, 2006 10:59 Al
1.5 MBE
320 240
Data Type: A
Play Time:

File Size:
Movie Size:

00'05
Lock: —
W 3tar Rating
w9
'.funime_nt g
| ¥

e

: MYI_O70B.AVI MWI_T357.AVI MVI_1675.4M1
el M
i Show All E] o —
View | Sht T v T
Movie mark

Use these buttons to advance
or rewind frames.
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_..- e q “ Selecting Images ,” 3|

The Viewer Window will open and display the movie if you
double-click the thumbnail. You can also play the movie in the
Viewer Window.

866

FIMVI_1357.AVI

Save as Still Image....
Fit to window [ e
B ([ ofeve

4 »

Back Next | Save

Lt g &=H 5 Zz % =

Displays w  Synchronife Show Infarmation w

157 % 4

Edit

320 x 240 Display :

You can save the displayed
scene as a still image.

You can play
movies and control
the sound volume.
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Editing Movies (1/3)

You can edit movies by adding various effects: linking movies and still
images that have been downloaded to a computer, superimposing titles
and other text, and adding background music.

PROCEDURES _
% Editing Movies

1_ Select a file (movie or still image) to edit in the
Browser Area.
You can select multiple movies or still images.

Click the [Edit] menu and select [Movie Edit].

Edit the movie by following the steps displayed on the
tabs in the window's midsection, then finish by saving it.

The features and procedures for each step are explained on the
following pages.

REFERENCE

* You can set the default preferences for movie edits by clicking
the [MovieEdit Task] menu and selecting [Preferences].

wN
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Follow these steps to Guidance Click this button for detailed help

proceed, switching between with operating procedures.

tabs as appropriate.

866 MovieEdit Task

Arrange images.

1. To arrange images, select the image and click on the [Move Left] or [Move Right] button.
g 2. Click the [Play] button to play the arranged effects and check them.

3. Click the [Effect] tab to go to Effect Step.

T & o

Move Left  Move Right  Properties Clear

Tofal Timg 0:05.1 v
. You can change thumbnail sizes
g vie Symbol in the storyboard area.
Transition Box
Displays the icon of the transition
effect used to link adjacent images.
Storyboard Area

Displays thumbnails of the selected images.
Links images in order from left to right.
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EXPLANATION .
Features of the [1. Arrange] Window
Plays the entire movie Moves the selected image one
being edited. position to the left or right.

Displays the properties of the

Adds images selered image.

MpvieEdit Task

(Arrange images.
1. To arrange images, select the imagq and click on the [Nlove Left] or [Move Right] button.
2. Click the [Play] button to play the afranged effects and fheck them.
3. Click the [Effect] tab to go to Effect

Total Time 0:05.1

selected image. from the storyboard.

You can set the playback range (start and stop points)
for a movie by selecting it and clicking this button.

You can set the play duration of a still image by
selecting it and clicking this button.

ImageBrowser Software User Guide

Rotates the Removes the selected movie

Features of the [2. Effect] Window

Superimposes titles and other text on the image selected in the
storyboard area.

You can set the font, display duration, display position and scrolling
attributes of the text.

You can change the movie or still image selected in
the storyboard area into a sepia or monochrome
version, or add noise for a film simulation.

MovieEdit Task

i
ffects to image.
apply effects to an image using the steps shown below. When it is unnecessary to apply effects to an
r you have finished applying effects, click the [Audio] tab and proceed to the Audio step.

a Text effect or Filter effect to an image. Select the image you want to apply the effect to, click the
ffect], [Filter Effect], or [Magnify Section] buttons, and apply the effect.
Lo T e

Ciioibo oo Coloct tho Teoocitioo Effoct boo b

~
i

Total Time 0:05.1 4

Magnifies part of the  You can set the transition effect between

selected image. images by selecting the transition effect
box in the storyboard area and clicking
this button.
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Editing Movies (3/3)

EXPLANATION _ _
Features of the [3. Audio] Window

You can link MP3, AIFF and WAV format audio files as background music
or sound effects.

When you link a sound file using this procedure, a bar appears under the

thumbnail in the storyboard area indicating the duration of the audio file.

MovieEdit Task

.‘;Add an audio effect.

finished adding audio effects, click the [Save] tab to go to Save Steps.
1. To add audio, click the [Add Audio] button.

2. When you want to arrange the audio clips, select the audio clips you want to arrange and click the [Move
Nl oft]l or [hoyn Richt]

Use the following steps to add an audio effect to an image. If an audio effect is unnecessary or you have m
a
v

huttan ta arranon than

& M|

nced  MoveLeft  Move Right  Properties Clear

a5 B

Total Time 0:05.1

You can adjust the volume or set the fade-in or fade-out
effect for a movie or its linked audio file by selecting the
movie or its linked audio file and clicking this button.

REFERENCE

© o o o o o o o o o o o e o o o o o o

e Sound files recorded with the camera's Sound Recorder feature
can also be linked as background music or sound effects.
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EXPLANATION _
Features of the [4. Save] Window

Proceeds to a window for setting
the file name and destination.

MovieEdit Task

806 l

?Save the edit results.
Clr(k [Save] button to save the edit results.

Save image type : r——) Auto-select
3] Specify a save image type
Motion-)PEG AVI

Advanced Settings
Save image type : Motign-JPEG AVl
File : .avi
Video : Motion JPEG OpgnDML, 320 x 240, 15.000 fps
Audio : PCM, 11.024 kHz, 8 bits, Monaural

Total Time - 0:05.1

You can set the options
for a movie file.

Select this to specify a file type and select a type
from the list immediately below.

Select this for the most commonly used settings for saving
(the [Advanced] button is disabled when this is selected).
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Extracting Stills from Movies (1/2)

This feature extracts still images from movies and saves them as image
files.

REFERENCE

* You can also save the specified image as a still from the Viewer
Window.

Extracting Stills from Movies

Select a movie from the Browser Area.

Click the [Edit] menu and select [Extract frames from a
moviel].

PROCEDURES
\®
1.
2.
3.

Set the still image extraction method.

m Extract all frames
Extracts all frames in the movie as stills. Please note that the
image numbers and file sizes may be large.

m Specify an interval and extract frames

Extracts frames as stills from a specified frame range or time
interval.
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m Specify the number of copies and extract frames

Extracts a specified number of stills from the entire movie. The
extraction interval is calculated based on an equal distribution
of the specified number of stills.

m Extract a specified image
Extracts stills from scenes that catch your attention.

MovieFrame Task

NSet the Extraction Method.
1. Select how you want to extract still images from a movie.
P 2. Click the [2. Preview] tab and move on to the next step.

0ﬁ§|ﬂa| movie file 9 Extract all frames
% Extracts every frame in the movie as a still image.
O Specify an interval and extract frames
r¢ Specifies the interval at which still images are extracted from the movie.
* 3% Frames ¥
File MVI_1357. O Specify the number of copies and extract frames
B Specifies the number of copies of still images to be extracted from the movie.
Image Size:320x240
Copies
O Extract a specified image
h L
=] Extracts the frame you select while watching a preview of the movie as a still image.
=[S
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4_ Click [2. Preview] and check the extracted stills. 5_ Click [3. Save] and set the file name and folder.
If you selected [Extract Specified Images] in the previous Sets the file name.

window, the movie will display in the left part of the window.
Display the images you want and click the [ =% ] button. (You
can add as many stills as you wish.)

MovieFrame Task

866
X =
ave still images.
‘ AP 3 % 4l 2. Click the [Save] pputton to extract the still image(s) from the movie and save.
At

Original moviea file Saved images: 401
e mov Required Disk Space: Approx. 9.9 MB

Rotates images (all). Clears check marks from all the
preceding or subsequent images.

Clears or adds
check marks from Changes the
or to all at once. thumbnail size.

MovieFrame Tafk
images. File name:
m the images to be saved. Images that arg checked will be saved.

ithe [3. Save] tab and moye on to the next gtep.

@ use original movie file name
() Specify a file name

' Example: MVI_2340_0001.jpg

Play Time:00:26.73 Auta folder creation:

Total Frames:401 @ Automatically create a folder with the same name as the original movie
Image Size:320x240 Pt v
) Specify folder name

Sets the folder name for auto play.

6_ Click [Save] and specify the destination.
Stills will begin to be extracted.

806 MovieFrame Task

ave still images.
l. Set up how you want the images to be saved.
o 2. Click the [Save] button to extract the still image(s) from the movie and save.

Play Time:0p:26.73
Total Framds:401
Image Size B20x240

I

You can'set the volume and play the movie Saves images with
at normal speed, half speed or double speed. check marks only.
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Viewing Images

Converting RAW Images (1/5)

If your camera supports RAW images you can handle higher quality
images.

However, since they are a special type of image, they cannot be opened
by many image editing programs. It is first necessary to convert them
into standard image files.

This section explains conversion procedures.

IMPORTANT

e This function may not be available with certain camera
models. Check your Camera User Guide to see if your model
supports it.

REFERENCE

* RAW images are extremely high-quality images that are not
subject to any deterioration due to compression processing.

ImageBrowser Software User Guide
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2.

Thumbnail
Check Mark
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Converting RAW Images

Select a RAW image in the Browser Area.

Click the [File] menu and select [RAW image processing].

When the window showing the procedures for converting and
adjusting RAW images appears, click [OK].

As shown below and on the following pages, the main
window, navigator window and Image Quality Adjustment
Window will display.

REFERENCE

------------------------------------------

e |f the Navigator window does not open, click the [View] menu
and select [Show Navigator] or click the window's upper right

L2 |

B oAl

Main Window
The conversion is conducted in this window.

"o

You can use these
buttons to switch
between images and
set the image rotation.

Preview
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Viewing Images Organizing Images

Converting RAW Images (2/5)

m Navigator Window
86806

Navigator

You can change the area of a preview
image that is zoomed in the main
window by dragging the red mark.

m Image Quality Adjustment Window

You can adjust the brightness,
contrast and coloration of a RAW
image as it is converted. See the
Features of the Image Quality
Adjustment Window on the
following page for details.

O () O Image Quality Adjustment

OO

Digital Exposure Compensation

- T

(-2.0 - +2.0]

‘irhite Balance

" auto I:j

Color temperature

—O_ szon K
( 2000 - 10000 )
Magenta Green
— o
{-100 - +100)
Tone Curve
Photo Effect
[of )
Contrast
= | —
hvi
(-5-+5]
Sharpness
= ;
hvg
[0-10]
Saturation
= p
hvi
(-5-+5]
Color Space
SRGB =
| Shot Settings Update
g Preview
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Adjust the image quality as required in the Image

Quality Adjustment Window.

image type and save
[Save].

Selects images that will be
saved with the same settings.

Click the [Save] button in the main window, set the

destination, and then click

Save
Conversion Target
@ All Images
_) Checked Images
() Selected Images
SetS the |mage type, Convert from RAW to other Image Type
compression ratio, Image Type: CExif-TIFF(8bit/ch) B

and I’eSO|uti0n Compression Ratio:

Resolution:

__jiLinear Image

180 pixel/inch (10-2000)

"] Embed ICC profile in image

Save folder

Sets the destination
folder for the image

@ save in Original Image folder

specified folder

Browse

ﬁle () Save in following
’ Users:CAP_G4:Desktop
You can change the Rename File
image file name. Do Not Modify
Prefix:

Example:

Assign Sequence No.

Number of Digits:

Start Number:

4 (0-9)

(" Cancel im'
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Converting RAW Images (3/5)

EXPLANATION
Features of the Image Quality Adjustment Window

The adjustable categories may vary according O O O Image Quality Adjustment

Chapter 5 Chapter 6
Organizing Images Using Supplementary Appendices Index
Features
0000

to your camera model. XOOOOXXHXK

Adjusts the digital exposure
compensation.

—

Digital Exposure Campensation ———

You can adjust the RGB channel

v 0.0 settings together or individually.
(20- 4201 . Tone cume
White Balance e ™
" Auto I—ﬂ //,.
AdeStS the white balance Calortemperature - —|r .-//
by the light source or color Vi s Szon K _ 7L/ /
temperature, etc. {2000 - 10000 ) L/ /
JMagenta Green Vil ‘
P A
1 -1000 - +100 ) é —
Taone Cutve npr 1] Owpl el
@ ( Losd :;-f s )
_ (Photn Erfect = —
Adjusts the photo effect, (o —B——1—— Selects preset color schemes or
contrast, sharpness and Contrast My Color custom color schemes
saturation. - 4 o (see next page for explanation).
(-5 -+51
Sharpness :
__?— 7
(0-10)
Saturation
Restores all adjustments to 1 W !
the initial shooting settings. Lok
ColorSpace
[ sRGB —=#3—You can set the color space for the output.
Shot Settings Update  ———\When there is no check mark in the
With a check mark here, settings changes in this W preview Preview box, this button will display the

window are immediately reflected in the image.
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image that reflects the selected settings.
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Converting RAW Images (4/5)

PROCEDURES
% Registering Custom Color Schemes (My Color)

If you register a custom color scheme as a “My Color” scheme,

you can apply this scheme easily to additional images when you
convert RAW images.

IMPORTANT

e To register a “My Color” scheme, two images are required:
the pre-adjustment image and the post-adjustment image.
Use ImageBrowser’s image editing functions to prepare the

two images before proceeding. Save the two images as BMP,
TIFF or JPEG images.

e My Color schemes cannot be used with some camera models.

9. Click the [Edit] menu, select [My Colors] and select
[Create and Add My Color] from the next menu.

File BTl View

Cut X
Copy W%
Paste eV
Select >
Rotate >
Tools >
Check Mark >
Development Conditions »
My Colors >

Create and Add My Color...

ImageBrowser Software User Guide
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2. When the Create My Color window displays, click
[Next].

3. Following the instructions on the My Color Wizard screen, continue the task by selecting the
Original Image and Target Image you created in Step 1.

The Original Image and Target Image are compared by the Create My Color Wizard and the method
for converting the colors is created as My Color.

4. Enter a name and add the My Color you created.

Using My Color
The My Color entry is added to the [Photo Effect] list box in the [Image Quality Adjustment] window.
You can select it from the [Photo Effect] list box and use it when developing RAW images.

‘When you have prepared the Original Image and Target Image, click [Mext].

—

-, < Back (—H [ Cancel )

3_ Click [Select] beside the original image, select the pre-
adjustment image (original image) and click [Next].

Create My Color Wizard

Select the Original Image To create My Color, you select the Original Image.

‘When you have finished selecting, click [Next).

Original Image

4 Select )

£ < Back > Next >

{ Cancel |
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Converting RAW Images (5/5)
4.

Click [Select] beside the target image, select the post-
adjustment image (target image that you have
modified with an image editing program), and click
[Create].

- IMG_0001 JPG

Target Image

[ —
{ < Back | Create [ Cancel |

The program will calculate the differences between the original
and target images, apply those corrections to the original image
and display the results as the [Preview My Color Applied to the
image].

Original Image Preview My Color Applied to the Image

Chapter 4 Chapter 5 Chapter 6
Viewing Images Organizing Images Using Supplementary Appendices Index
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0000

Check the [Preview My Color Applied to the image]
and click [Next].

Type a name or comment and click [Finish].

REFERENCE

------------------------------------------

* You can apply the registered My Color scheme to additional
RAW images when you convert them by selecting it from the
[Photo Effect] menu in the Image Quality Adjustment Window.

EXPLANATION

-@ Other Features

You can also use the following features in the Main Window.

PrrrR

IMG_0001 IPG

Target Image

IMG_0002 IPG
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You can open converted images Displays shooting
in other application programs. information.
Displays histograms.
RAW Image Task N
3 | = & N A a —(m)o )
Adjust Transfer Saye h 24 6% @ E -
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Stitching Panoramic Images - PhotoStitch

If you have several images of the same scene with only a slight 3
difference, you can use PhotoStitch to connect the images -
together to make a panoramic image. This section describes

how to use this program to stitch images.

REFERENCE

------------------------------------------

e For detailed information on how to use PhotoStitch, refer to the T p |
PhotoStitch Help (accessible from the [Help] menu).

* You can stitch images together more readily if they have been
recorded using the camera’s Stitch Assist mode because
PhotoStitch can automatically detect the image order and merge

Follow the instructions on the upper part of the
PhotoStitch window.

‘806 PhotoStitch
Merge Images Shot in Stitch Assist Mode ‘

Click [2. Merge] to merge these images.
For images shot as a 360-degree panorama, click [Arrange], select
[360 Degrees] and then click [2. Merge].

Decide the order

direction. Some cameras may not feature the Stitch Assist mode. L in which the
i images should be
No.of Images:d | 3072 %2804 True Color tt h d
PROCEDURES _ _ SHene
Opening PhotoStitch
@ v

In the Browser Area, select the images that you want
to stitch together.

7 2006_09_09
7 2006_09_10 == ]
[§ 2006_09_11
[§ 2006_09_12
@@ sTrcH

b (7 iPhoto Library

Perform stitching.

Mo of Images: 4 Panning (Scenery , eto.) Fooal Length Auto Acquire - Canon 7

STA_9708.JPG STB_9709.JPG STC_9710.JPG STD_9711.JPG ‘

=] EIC View [§F vt || =m0, @ || e || 3 @
A&
Favoril ite
- : S ]
4 =2 TN @
S L o b S iz < Fritt  w  Sendto Trash

Na. of Imagss Selected: 4 / Totak 4 images

2_ On the [Edit] menu, click [PhotoStitch].
PhotoStitch will start.

Save the image.

Image Size: 2677 % 604 4
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Supported Image Types

The following is a list of image types supported by ImageBrowser.

EXPLANATION
Readable Image Types

ImageBrowser can read the following image types.

® JPEG

Most cameras use this image type. It compresses at very high
ratios, taking advantage of the characteristics of the human
eye. However, because it is an irreversible compression method
(part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may
become rougher.

Exif JPEG is an image type that adds information such as
shooting data to a JPEG image.

= RAW

This is a proprietary image type provided by Canon. It allows
the output of the image pixels from a digital camera without
any deterioration in the quality of the image. Some cameras
might not support this image type.

= PICT

This is the standard image type for Macintosh. This image type
is supported by most Macintosh software.

ImageBrowser Software User Guide

= TIFF

This is a relatively popular image type. It is widely supported by
non-Macintosh programs (such as Windows).

= Windows Bitmap

This image type comes standard with Windows. Most Windows
programs support it.

® QuickTime/AVI

These are movies, which display as a movie icon in the Browser
Area of ImageBrowser.
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You can simplify many ImageBrowser procedures by changing the EXPLANATION ] ]
Preference settings. This section explains the main features that can be Browser Window Dialog
adjusted in the Preferences dialog.
Change the Allows you to set the Allows you to set the
PROCEDURES . . category here. color of each area in background color of
Opening the Preferences Dialog the Browser Area. the Preview window.
Use the following procedures to open the Preferences dialog. Preferences
_ Browser Window | 3" —
Click the [ImageBrowser] menu and select [Preferences] to _ E——
. . K . . Thumbnail Area E—
display the Preferences dialog. You can use this dialog to switch FraliE o T —
between the various categories to change settings. Background Color [
= Preview Area . % —
E & BECEHGHEIE File Edit  View  Background Color T
Ehﬂ' I |magEEEQHE5EE E{Zmale Custom Icon for Images
Register Application
Preferences... £ — - - =
Services > | :dld
Hide ImageBrowser &H
Hide Others ¥EH
Show All If you select this, when you display
kst images in ImageBrowser, a customized
Quit ImageBrowser  38Q icon is automatically attached to them.

Specifies the program(s) displayed on the [Start Application] submenu on the
[Edit] menu. You can add programs using the [Add] button on the right.
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Customizing Preferences (2/4)

EXLANATON _ _ EXPLANATION _ _ _
Viewer Window Dialog Confirmation Dialog
Place check marks beside the categories Sets whether or not confirmation messages display when the
to be displayed as image information. respective functions are utilized.
Preferences fme
; [ Viewgr Window F#'J . Confirmation Dialog Box [
Seleqt the shooting information you want to be dispalyed in the Viewer — i
i ( Cancel ) i rﬂlﬁn’nzﬂ:mn Dialog Box
= EDisplays the message dialog box when placing a folder into the Trash.

L File Name m BDisplavs the message dialog box when displaying the Search Results folder.
] Camera Model

["] Shooting Date/Time

EShoming Mode

] Photo Effect Mode
ETWShutter Speed)
EA‘-’{APERWQ Value) # Displays the message dialog box when images marked To Do are downloaded.
] Metering Mode

EExposure Compensation

[l Digital Exposure Compensation f|
[] Autoexposure Bracketing '7

gDisplavs the message dialog box when filter settings are changed.

SDispla\r the RAW Development Confirmation dialog box.

EDisplavs the message dialog box when movies with Rotation Information are
plaved.

€ Select All — & Deselect All )

You can select/deselect all at once.
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Customizing Preferences (3/4)

EXPLANATION
Thumbnail Cache Dialog

When you select a folder from a peripheral, such as a CD-ROM
or CD-R, in the Explorer Panel Section, ImageBrowser creates a
file in a predetermined folder for the thumbnail displayed in the
Browser Area.

However, when viewing a CD-ROM or a CD-R containing a
large number of files, the number of thumbnails also increases,
resulting in less free hard disk space on your computer. In this
case, you can use this dialog to delete unnecessary thumbnails
(thumbnails for files on a CD-ROM or a CD-R that you have
already looked at and probably will not look at again).

To delete the thumbnails, click the appropriate disk name in this
dialog. The thumbnails for that particular disk are deleted. (The
thumbnails are not actually deleted until the next time you start

ImageBrowser.)
§ Preferences
[ Thumbnail Cache | AN _—
Creating the thumbnail cache data for a Read-Only image. (—TL-J

All of the thumbnail cache data for the following volumes can be cleared
at once.

L s esashadiem for clearing.

| Datal
[] Data2

|
Select a disk.
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EXPLANATION _ _ _
Processing When Rotating Dialog

ImageBrowser rotates and displays images to match how they
are displayed in the camera. However, it does not alter the
image data itself. If a rotated image is opened in a program
that does not support rotated display, it will appear in its pre-
rotation state. You can have the image data itself rotated when
it is downloaded from the camera by changing the setting for
[Processing When Rotating]. You can rotate and save movies by
clicking the [Edit] menu and using the [Edit Movies] submenu.

Preferences

r Processing When Rotating v ]

-
Rotation process when a JPEG image is downloaded from a camera m
[ Rotate an original JPEC image
A JPEG image that was rotated in the camera contains rotation information in the
shooting information. If you select this check bex, the actual JPEG image will be rotated
based on the rotation information in the shooting information at the time the image was
downloaded from the camera.
However, if an image has original decision data appended, the actual image will not be
rotated.
Place a check mark here to convert image data
to the vertical orientation while downloading
images shot with the camera on end.
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Customizing Pref (4/4)
EXPLANATION . EXPLANATION . .
Print Dialog Units Dialog
Selects the information displayed as captions RS
for each image in the Layout and Print process. " Units F —
—o—
Preferences Length — @
_ Print 4
_Items printed in the caption in Layout Printing { 'W') inches | :
[l shooting Date —
[l Shooting Time
[ IFile Name
Default Print Window Direction of Rotation
Orotae tefe Jf] @ Rovace iohe [F Use this to set the units used for measuring
e g el e the paper size in the Print window.
direction as viewed from behind the camera.
EXPLANATION
Color Management
When an image in the landscape orientation is selected in fraferences
[One Photo per page Prin_t], the image is al_JtomgticaIIy ( Colorilifement B
rotated 90 degrees and displayed in the Print window. € o
This sets the rotation orientation for that process. Images will be displayed using the color space selected when they were ( Cancel )
shot. For more information about these settings, see the ImageBrowser's
Readme.
REFERENCE Mote: When these settings are applied, the display speed may become
R L EE R A W CREREREEFTR. EERERE it daoea s Ghvoi St
e To print with the date included, place a check mark beside the B
[Shooting Date] option in the [ltems to Print in Caption] S Atk color matening
category. Then select an image in the Browser Area and use the e b e e
layout print procedures to automatically display the shooting
date.
Use this to display image colors in the color
space specified while shooting the image.
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Troubleshooting
This section explains solutions to software problems. See the user m Check the Connection between the Camera and the
guides for your camera for solutions to camera or wireless connection Computer
problems. Check to ensure that the camera and computer are correctly
EXPLANATION connected by the interface cable. See your Camera User Guide
Camera is not detected or recognized for connection methods.
e The “Camera not detected” message or a similar message m Check the Camera
displayed when you attempted to download images from the Confirm that the camera is on and in the correct mode to
camera. _ , , , transfer data. See your Camera User Guide since the methods
* Camera Control Window will not open despite setting any for setting the camera and computer to the communication
one of the following settings, even when the camera is mode vary between camera models.
connected to the computer with the interface cable and is set
to the data transfer mode. m Check the Battery
— Click the [File] menu in the Camera Control Window and You are recommended to use a household power source (AC
place a check mark beside [Start When a Camera is adapter) for the camera when connecting it to the computer. If
Connected]. the camera is running on batteries, ensure they are fully
— In Image Capture’s [Preferences] menu, specify charged.
[CameraWindow] in the [Application to open when a
camera is connected] section. EXPLANATION
How.to Get Help

When ImageBrowser does not start even though you have
enabled communication, or when you try to import images
from the camera and the “Camera not detected” message or a
similar message appears, check the following, in that order.

ImageBrowser comes with a Help file. Use it when you want to
learn how to do an operation, or when you want to know
about the features of the application. You can access Help by
clicking [ImageBrowser Help] on the [Help] menu.

m Check Your Computer

File Edit View Internet Window
Confirm that your computer satisfies the following conditions. (Cimagesrowser rep__w_)
Computers not meeting these conditions are not supported.
e Macintosh computer equipped with USB ports as standard
equipment
e Mac OS X 10.3-10.4 (preinstalled)
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A" AddText 109
Adding Computer Images to the Camera 42
AIFF 100
Auto Adjustment 80, 88
Auto Download Settings 17, 19
Auto Play 96
Automatic Start Up 9
AVI 127

B P 127
Brightness 80, 88
Browser Area 7, 48
Browser Window 6

C Camera Browser Window 22, 24, 25, 28, 32
Camera Control Window 6, 9, 11, 15
Camera Settings 41
Canon Camera 16
Caption 108
Clear 106
Color Management 131
Color/Brightness Adjustment 80, 82
Comment 77
Contextual Menus 7
Control Panel 52
Copying Images 73
Creating Folders 79
Creating Images for E-mail 91
Creating My Camera Setting Files 39
Custom Layout Printing 104
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Viewing Images Organizing Images

Deleting Images 75
from the Camera 24
Deselecting All Images 61
Destination for Downloaded Images 23
Destination for Downloaded Sounds 27
Direct Transfer Function 8, 15, 17
Direct Transfer menu 9, 17
Display Magnification 56
Display Mode 50 H
Displaying Multiple Images 57
Displaying the Subject on the Camera’s LCD
Monitor 45
Downloading Images 8, 9, 17, 18, 19, 22
Camera Operations 17, 18 I
Checking Images before Downloading 22
Computer Operations 19
Downloading Sound Files 25
Duplicating Images 74

Edit Text 109

Edit with Registered Application 80, 90
Editing Images 80

Editing Movies 116

Explorer Panel 48, 52 J
Exporting Images 93
Extract Frames from Movie 59, 119 K

Chapter 6
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File Information Dialog 77
Filter Tool 53, 64

Fixed Photo Size Printing 104
Font 108

Font Size 108

Font Style 108

Full Screen Display 56

Header 110

Help 132

Hiding the Explorer Panel 52
Histogram 77, 85

Image Information 58, 77, 78
ImageBrowser 5
Closing 47
Starting 47
Index Print 102
Information Displayed with Thumbnails 54
Information Panel 50, 52
Insert Text 80, 84
Interval Timer Shooting 45

JPEG 127

Keywords 65, 77

Last Acquired Images 10, 12, 48
Layout Print 104

Level Adjustment 80, 85
List (Display Mode) 51
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Index (2/2)
Sorting Images 67
M Moving Images 73 RAW 58, 121, 127 Sorting Thumbnails 54
Multiple Page Print 111 Recording Sounds 99 Sound Recorder 25, 114
My Camera Settings 33 Red Eye Correction 80, 83 Sounds 99
My Camera Window 34 Refresh 73 Star Rating 62, 77
My Color 124 Registering as a Favorite Folder 49 Stitch Assist Mode 126
Remote Shooting 43 Synchronizing Multiple Images 57
N New Folder 79 Renaming Images 69
RGB (Red, Green, Blue) Intensity 80, 82 T Text Alignment 108
0 Opening Images 55 Rotating Images 76 Text Color 108
Owner's Name 41 Theme 34
Saturation 80, 82 Thumbnails 50
P PhotoStitch 126 Saving and Recalling Shooting Settings 45 TIFF 127
PICT 127 Saving Images 89 Tiled Photo Printing 104
Playing Movies 59, 115 Screen Saver 93, 95 Timer Shooting 45
Playing Sound Files 114 Search 71 T!meTunneI 112
Playing Sound on Images 100 Searching Images 71 TimeTunnel (D|_splay Mode) 51
Preferences 128 Selecting a Single Image 61 Tone Curve Adjustment 80, 86
Preview (Display Mode) 50 Selecting All Images 61 Tool Panel 113
Print Resolution 111 Selecting Folders 48 Tracking 108
Print/Share Button 9 Selecting Images 61 Trim Image (Print Window) 107
Printing a Single Image on a Single Page 13 Selecting Multiple Images 61 Trim Image (Viewer Window) 80, 81
Printing Images 13, 101, 102, 104 Send to Trash 75 v
Camera Browser Window 28 Sharpness 80, 87 Viewer Window 55, 56, 80
in the Camera 29 Shooting Information 58, 77, 78 Viewing Image Information 77
Viewer Window 59 Showing the Explorer Panel 52
Slide Show 96 W \/\/a||paper 93, 95
Q QuickTime 127 WAV 25
QuickTime Player 114 Windows Bitmap 127
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Disclaimer

e While every effort has been made to ensure that the information contained in this guide is accurate and complete, no liability
can be accepted for any errors or omissions. Canon reserves the right to change the specifications of the hardware and software
described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language
in any form, by any means, without the prior written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a mistaken operation or malfunction of
the camera, the software, memory cards, personal computers, peripheral devices, or use of non-Canon memory cards.

Trademark Acknowledgments

* Macintosh, the Mac logo, QuickTime and the QuickTime logo are trademarks of Apple Computer, Inc., registered in
the U.S. and other countries.

CDA-E012-010 © 2007 CANON INC.

ImageBrowser Software User Guide 135 Back Next




	Canon Utilities ImageBrowser Software User Guide
	Table of Contents
	Notations and Conventions
	Symbol Usage

	Chapter 1  What is ImageBrowser?
	What Can ImageBrowser Do?
	What You Can Do with a Camera Connected
	View Images
	Organize Images
	Use the Additional Features

	Guide to the ImageBrowser Windows
	Camera Control Window
	Browser Window
	Using Contextual Menus


	Chapter 2  Downloading and Printing Images
	Downloading Images to a Computer
	Connecting the Camera to Download
	Using Camera Commands to Download Images
	Using Computer Commands to Download Images

	Printing a Single Image on a Single Page

	Chapter 3  What You Can Do with a Camera Connected
	Camera Control Window
	Opening the Camera Control Window
	Closing the Camera Control Window

	Downloading Images Automatically—Camera Operations
	Starting Auto Downloading
	Changing the Auto Downloading Settings

	Downloading Images Automatically—Computer Operations
	Starting Auto Downloading
	Changing the Auto Download Settings

	Checking Images in the Camera before Downloading
	Selecting Images and Initiating the Download

	Deleting Images from the Camera
	Downloading Sound Files from the Camera
	Initiating Downloading

	Other Features of the Camera Browser Window
	Printing Images in the Camera
	Four Printing Methods
	Printing Procedures
	Print All Images
	Print According to DPOF Settings—Standard
	Print Contact Sheet of All Images
	Print According to DPOF Settings—Index
	Select image and print

	Saving the “My Camera Settings” to the Camera
	What are the My Camera settings?
	Displaying the My Camera window
	Saving the My Camera Settings to the camera
	Saving the Settings to the Computer
	Using Other My Camera Settings
	Creating and Adding Files as My Camera Settings

	Checking and Modifying the Camera Settings
	Adding Computer Images to the Camera
	Operating the Camera Shutter from a Computer
	Remote Shooting Procedures
	Features of the RemoteCapture Task Window
	Other Remote Shooting Features
	Remote Shooting Default Settings


	Chapter 4  Viewing Images
	Starting ImageBrowser
	Starting ImageBrowser
	Closing ImageBrowser

	Selecting Folders
	How to select a folder
	[Favorite] and [All]
	Registering a Folder as a Favorite Folder
	Unregistering a Favorite Folder

	Changing the Display Mode
	Three Display Modes

	Changing the Browser Window Display
	Switching between Showing/Hiding Panels
	Filtering the Thumbnails Displayed
	Setting the Information Displayed with Thumbnails
	Sorting Thumbnails

	Opening Images
	How to open an image
	Opening several images

	Using the Viewer Window
	Opening the Previous or Next Image
	Changing the Display Magnification
	Using the Full Screen Display
	Displaying Multiple Images
	Synchronizing Multiple Images
	Displaying Image Shooting Information
	Converting and Displaying RAW Images
	Playing Movies
	Printing Displayed Images
	Closing the Viewer Window


	Chapter 5  Organizing Images
	Selecting Images
	Selecting a Single Image
	Selecting Multiple Images
	Selecting All Images
	Deselecting All Images

	Setting Star Ratings
	What is a Star Rating?
	Setting the Star Rating
	Other Settings Methods for Star Ratings

	Using the My Category Function
	The My Category Function
	Displaying the Last Acquired Images by Category
	Filtering Images with the My Category Function
	Selecting the Images from the Specified My Category

	Assigning Keywords
	Keywords
	Assigning Keywords
	Other Ways to Assign Keywords
	Managing Keywords

	Sorting Images
	Selecting a Sorting Method
	When [The files will be separated into folders for each shooting date.] is Selected
	When [The files will be organized by Star Rating.] is Selected

	Renaming Images
	Renaming Images
	Changing Multiple Image File Names
	Renaming Folders

	Searching Images
	Moving and Copying Images
	Moving or copying in the Explorer Panel Section
	Moving or copying images using two Browser Windows
	Other Methods
	Duplicating Images

	Deleting Images
	How to delete an image
	Deleting Folders
	Other Methods

	Rotating Images
	How to rotate an image
	More ways of rotating images

	Viewing Image Information
	How to view image information
	Viewing Information in the Viewer Window

	Creating Folders
	How to create a folder


	Chapter 6  Using Supplementary Features
	Editing Images
	About the Editing Features
	Trimming
	Adjusting Color and Brightness
	Red-Eye Correction
	Insert Text
	Adjusting Levels
	Adjusting Tone Curves
	Adjusting Sharpness
	Auto Adjustment
	Saving images

	Editing Images with Other Programs
	Registering Image Editing Programs
	Starting an Image Editing Program

	Creating Images for E-mail
	How to send an image by e-mail

	Exporting Images
	Export Options
	Exporting Images
	Editing and Saving Images
	Exporting Shooting Properties
	Exporting as a Screen Saver
	Exporting an Image as Wallpaper

	Running Slide Shows
	Setting up a slide show
	How to run a slide show
	Slide Show Control Panel

	Adding Sounds to Images
	How to add a sound to an image
	How to play sound added to an image

	Printing Images
	Three Printing Methods

	Printing Indexes
	Layout and Print
	Setting the Layout in the Preview Area

	Printing Images over Multiple Pages
	Multiple page printing

	Sorting Images by Date and Time - TimeTunnel
	Displaying images in TimeTunnel
	Using the Control Panel menu
	Using the Tool Panel
	Adjusting settings from the Display menu

	Playing Sound Files
	Playing Movies
	Editing Movies
	Editing Movies
	Features of the [1. Arrange] Window
	Features of the [2. Effect] Window
	Features of the [3. Audio] Window
	Features of the [4. Save] Window

	Extracting Stills from Movies
	Extracting Stills from Movies

	Converting RAW Images
	Converting RAW Images
	Features of the Image Quality Adjustment Window
	Registering Custom Color Schemes (My Color)

	Stitching Panoramic Images - PhotoStitch
	Opening PhotoStitch


	Appendices
	Supported Image Types
	Readable Image Types

	Customizing Preferences
	Opening the Preferences Dialog
	Browser Window Dialog
	Viewer Window Dialog
	Confirmation Dialog
	Thumbnail Cache Dialog
	Processing When Rotating Dialog
	Print Dialog
	Units Dialog
	Color Management

	Troubleshooting
	Camera is not detected or recognized
	How to Get Help


	Index

